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System requirements

Computer: IBM PC (or compatible)

Operating System: Windows XP, Windows Vista and Windows 7
(32-bit and 64-bit compatible)

Minimum Software: Windows Installer 3.1*

Microsoft .NET Framework 2*

Microsoft Internet Explorer 8.0**

Adobe Reader software (V7.0 or above)*™

Display: Minimum 800 x 600 with 256 colours
Recommended: 1024 x 768 with high colour - 16-bit

* If Microsoft .NET Framework 2 or Installer 3.1 is not detected during the installation set up process,
they will be automatically installed prior to the EASYSENSE application install. This will extend the
installation time significantly.

** V8 minimum Internet Explorer is required to view documentation on the EasySense CD. To view and
print PDF files you will need Adobe Reader installed.

Installing the EASYSENSE software

USB users: Make sure the EasySense logger is not connected to the USB port prior to, or while, the
EASYSENSE software is being installed.

e Logon as ADMINISTRATOR (or with equivalent access rights) on the system.

e Close any open programs — you may need to restart your machine for configuration changes to
be made.

e Insert the EASYSENSE CD ROM into the CD Drive. Windows should detect the CD and
automatically start up the EASYSENSE auto run program. If auto run fails to start, use Windows
Explorer to navigate the CD ROM contents and double click on the Setup.exe file.

e Follow the on-screen instructions to complete the installation of EASYSENSE and its associated
files* onto the hard disk.

o When the installation is complete, eject the CD ROM and store it safely. Restart your system.

* Complete installs all, whereas a Custom install allows you to deselect the installation of logger manuals or to
change their installation path.

A Windows installer package (.msi) of the EASYSENSE software is available. The .msi package for
o 32 bit systems is supplied in the i386 directory and for
e 64 bit systems in the amd64 directory.

(To check your system properties, click on Start, right click on Computer and select Properties).

See page 53 for information on altering the default locations for data and setup files.

Downloading the EASYSENSE software from our website

The 4500 EASYSENSE software is available as a download from the Data Harvest website (www.data-
harvest.co.uk). Save the compressed file to your computer, then ‘unzip’ it to extract all files before you
run the setup.exe or msi.

Note: The method used to unzip a file will depend on the computers operating system and the decompression
program on your computer. For example:

1. Download the 4500 EasySense software zip file; select to Save itto a !E! 4500 ,J 4500
temporary directory on your computer. i 54,38 B

2. Right click on the zipped 4500 directory and select Extract All (or Compressed Decompressed
Extract or Unzip). Select the extract destination as the temporary (zipped) folder (unzipped) folder

directory. When the 4500 directory has decompressed the folder will
appear minus its ‘zip’.
3. From the unzipped folder either run the Setup.exe or select the appropriate Windows installer package (.msi).
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Connecting an Interface or Data logger

e USB connection
The first time an EASYSENSE unit (e.g. Vu, VISION, 1Link, 3Link, Q3+, Q5+, Q3, Q5, Qt Timer,
QLink, or Q Advanced) is connected to a USB port on the computer, the USB drivers will need to
install.

Connect the EASYSENSE unit to the USB port on the computer. Windows will automatically detect
a new device and install the drivers.

e Bluetooth™ connection:
Use the instructions provided in the EASYSENSE logger’s user manual.

e Serial connection:
Connect the interface/data logger to the serial port on the computer. Note which serial port you have
connected to e.g. COM 1, as this information will be required when you start the EASYSENSE
software.

Starting the EASYSENSE program for the first time

Start the EASYSENSE software e.g. Start » Programs » Data Harvest » and click on
EASYSENSE Software.

Select the Language
If a choice of language is available a Set Language window will open.

To choose a different language, select from the drop-down menu and OK. The program will close. Restart
to apply your choice.

Select a User level
The first time the EASYSENSE program is opened a ‘Select Program Level’ window will automatically
open. Select a suitable user level.

e Level 1is aimed at ‘start’ level (e.g. up to 9 years old)
e Level 2is aimed at ‘mid’ level (e.g. 9 — 15 years old)
e Level 3is aimed at ‘exam’ level (e.g.15 years plus)

Note: The program level can be altered by clicking on the Level icon and cycling through the levels

(one bar for Level 1, two for Level 2 and 3 for Level 3). The currently selected level will be saved
when the EASYSENSE program is closed.

Select an Interface and Connection
The first time EASYSENSE is opened a ‘Select Interface’ window will automatically open to allow the
correct interface and connection to be selected.

|
(a) Select the correct interface from the drop-down menu. - IMC [ E
e EasySense Range for an EASYSENSE data logger or
X ( a) —p|  EasySenseRange v
interface
e Flash Logger for the EASYSENSE Flash Logger (XP only) Cornection
e Sense and Control for the Sense & Control or Sense & P O seralpot
Control EasyLog. (b) Blustooth Communications Port [COM3] -
e Example Data for stored example data to show how sensor P| @usepor
readings are displayed. If this option is selected you will not (C) —»| DIstomasaun
be able to collect data from your interface or data logger.
(b) Select the appropriate connection i.e. either Serial or USB Port. 4
e If you are connecting via a USB lead, select USB Port. (d)

e If you are using a serial lead, select Serial Port and then the number of the communication port
used from the serial port drop-down list e.g. Communications Port (COM1).

e If you are using a USB/serial adapter, select Serial Port and then the adapter from the serial
port drop-down list e.g. AMC232USBDH USB Serial Port (COM4).

© Data Harvest Group Ltd. 5
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e If you are using Bluetooth, select Serial Port and then the serial port configured for Bluetooth
from the serial port drop-down list e.g. Bluetooth Communications Port (COMS).

(c) If these settings will stay the same leave the ‘Show at startup’ box unticked.

If the box is ticked (enabled) the ‘Select Interface’ window will automatically open when you next start
EASYSENSE, so you can check that the currently selected Interface and method of connection are correct.
This is useful if you use different types of interface (e.g. both Sense & Control and EASYSENSE Advanced
units) or if the interfaces use different methods of connection (e.g. use both EASYSENSE Advanced units
which connect via a serial port and EASYSENSE LINK units which connect via a USB port).

(d) Click on OK. The program will save the current selection.

Note: To change this selection at any time, CANCEL any ‘failure to connect’ errors, select Interface from the
File menu and alter the selection.

The Home screen

Home is the main navigation screen, which contains the icons for all available options.

The appearance of the Home screen and the complexity of the toolbars and functions in the
experiment options are altered by the user level selected.

Note: If the interface/data logger detected cannot use an option, it will appear greyed out e.g. the Setup Remote and
Retrieve Remote options will only be available for data loggers that support remote data collection.

Home - Choose Experiment Type

New Experiment

=]

Easplog

SnapShot
Options

Remote

Pictogram

Counting

Meters

©

Timing

Hame - Choose Erperiment Type

—
[¢)
<
2 E
—_

Mew Experiment

=

Easylog

-

SnapShot
Options

Remote

=)

Giaph

Counting

Home - Chaose Experiment Type

New Experiment

.

Easylog

BH=

SnapShaot
Options

Level 2

Meters

The Meters window gives an introduction to
sensors and how they respond to change. Up
to four section displays can be open at any
one time and they can be any combination of
sensors and displays.

See page 9.

Pictogram e nEn e o
The value from the sensors can be displayed S
as images or an abstract colour block or bar
chart. Each image represents a 10" of the
range (or span) of the sensor and is also
displayed as a number from zero to ten.

Note: Pictogram is only available if the User level
is set to Level 1.

See page 11.
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Easylog EEBRD B DD
The window will open pre-set to record sensor [

values continuously as aline graph untit |

stopped. EZ

See page 13.

Snapshot N E el T

The window will open pre-set to record sensor =
values on demand (manual sampling) with a [ =i
bar graph display. =

See page 14.

chosen time span as a line graph display.
The window opens with a real time logging
wizard from which the time span, interval
between samples, start condition and
triggers for the recording can be chosen.

Graph
\/V\ Use graph to record sensor values against a

Note: Graph is only available for User level 2 or 3.

See page 14.

Sc_ope . . DERERRE & BOD

A simple oscilloscope type display. The data  ———
- | from a sensor is redrawn continuously on the

screen. ldeal for demonstrating fast events
where there are rapid changes such as ECG
traces, sound waveform, etc.

Note: Scope is only available for User level 3.

See page 16.

g’ ffggigifi
e R 1

Timing
@ Timing is used to allow students to study

Time, Velocity, Acceleration, Momentum and
Kinetic Energy relationships using switch-
type (digital) sensors such as Light gates.

See page 17.
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Counting O
Use to count events by using switch-type (digital) | —— m

sensors. The chart type can be displayed as

images or a colour block or bar chart oriented

either horizontally or vertically. o

Note: Counting is only available if the User level is
set to Level 1 or 2.

See page 23. e

= >

Open File
Used to load a previously saved .SSL or .SID file. Locate the correct file and click on open.
See page 47.

Open Setup
To select and open an experimental setup file. This will pre-set the software for a specific operation.

See page 49.

Open Worksheet
To select and open a worksheet and its accompanying experimental setup file.

See page 48.

>

Set up Remote e

Used for setting up the options to capture data while disconnected = E
from the computer (remote). These options can include the duration of e —
a recording, the time between each sample and triggers. e —— L
See page 50. S '

Retrieve Remote (oo™ e -3}
Use this option to retrieve a data set stored in your R T T T
data logger's memory. See page 52. 2$1taen 210 e

Ermo the s et o e Ligigee #her Fntooren

— — —
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The Meters option

Start/Stop icon

[T Datf Farvest Easyien fa
Menu bar — Fierdit Display Settings Tools  Help Ele« — User Level icon

Toolbar —p, m [ [© = K

Home Options Gauge Changes Dial Numeric Notes Transfer to Graph
Information —>
window 1) Temperature (*C) = 3 (%= ][ 1) Temperature (°C) - | = | == 44— Close section window

2 6 2 <«4—+— Section window
|

;— Maximise window

Sensor and its unit

of measurement —| I Temperture () = [® ][5z ]| 1) Tempersture ) o ==
138.0 :
RN ol [ —
94.0 7 <
Right
Y -
50.0 [/
[~ - Senear Selactitn 2

6.0

-38.0

Status bar —p

When Meters is selected from the Home screen, the window will open with live data being displayed from
a sensor in a Numeric window.

Click on the Stop icon n to stop data being recorded.

To begin recording again click on the Start icon. !'J

¢ Up to four section windows can be open at any one time and they can be any combination of sensors
and displays.

¢ A section window can be opened either by clicking on the appropriate icon on the Toolbar or from the
drop-down Display menu.

e To alter the sensor displayed in a section, right click with the mouse in the section window and a
Sensor Selection window will open. Select the sensor to display in that section from the list.

¢ Click on the close button Lj to close a section window.

¢ A section window can be maximized to fill the whole window by selecting the maximize button, E click
again to return to ¥4 screen size.

e Click on the Home icon @ to return to the Home screen

;‘*‘ As soon as you open Meters or you click on the Start/Stop icon, the data is recorded ‘behind the
scenes’. This data can be transferred into the Graph window for display and analysis using the
Transfer to Graph icon (or select from the Edit menu). When in Graph click on the Back to Meters

icon E ‘to return to the Meters window.

© Data Harvest Group Ltd. 9
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Changes

This is the simplest of all four sections. It displays a
block of colour that changes to reflect the value being
collected by the sensor.

Colour changes happen within the span of a
sensor’s limits. The minimum and maximum of these
limits can be altered in Sensor Settings from the
Display menu or Options icon.

For example:

DO135 (6)

1) Temperature (*C)

= [@]E=]

Temperature - begins at light blue (coldest) and then works its way up to become dark red (hottest).

Light - begins at black (no light), works through greys until it becomes white (full light).

pH — simulates the colour change of universal indicator.

Sound and other sensors — begin at dark green (minimum), becomes lighter until works through

to bright green (maximum).

Note: To alter the sensor displayed, right click in the section window and select the required sensor from the Sensor

Selection window.

Gauge

This section will display a simple bar gauge that
increases and decreases with the measured value.

The scale on the left-hand side is divided into sections
to correspond to the sensor it is representing.

The maximum and minimum values recorded will be

displayed on the right-hand axis by two short lines if

Show Min Max from the Display menu is ticked. Use
Reset Min Max from Display to reset these values.

Dial
This section displays a traditional dial whose pointer

moves to the right as the measured value increases and
moves to the left as the value decreases.

The scale around the dial is automatically set by the
software to correspond to the sensor it is representing.

Two thin lines will display the maximum and minimum
values recorded if Show Min Max from the Display
menu is ticked. Use Reset Min Max to reset these
values.

Numeric

This section displays the currently measured value
as a number.

The maximum and minimum value recorded will be
displayed if Show Min Max from the Display menu
is ticked. Use Reset Min Max to reset these values.

Decimal numbers can be switched off by deselecting
Display Decimals in Sensor Settings from the
Display menu or Options icon. Without decimals
selected, the reading will be rounded up to a whole
number.

© Data Harvest Group Ltd. 10
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110.0 —

92.5 =

75.0 —

57.5 —

40.0

3) Sound (dBA}

3) Sound (dBA)

Min 43.0

Max 104.3
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Sensors

The sensors are automatically identified when the Meter option is selected. To change sensors while
Meters is logging, simply replace the sensor with a different type. Meters will automatically change the
sensor settings so that the correct calibration scales are displayed. If not logging then the change will
be detected once logging has started.

To alter the sensor displayed in a section, right click with the mouse in the section window and a Sensor
Selection window will open. Select the sensor to display in that section from the list.

The display colour, decimals, name and the minimum and maximum limits of a sensor can be altered
either from the Display menu or Options icon. See page 32.

To change the range of a sensor e.g. to alter the range of a Heart Rate sensor from Waveform to Beats
per minute select Sensor Config from the Settings menu (see page 42).

u The Pictogram option = User Level 1
|
M Data Marvest LasySeme Saftwan:
Menu bar —P e e e _ _ i ==« 4— User Level icon
Toolbar —» | 1 |f =l F L B
Information —! s

<4— Double left click in
the area above
the chart to enter

' § ﬂ § a Title
iaht Add Text
i : B T e

Right click within the graph
area for Add Text and Title

Sound 5 ! '

Temperature 5 | i |

i o

The program will open with values from the sensors displayed as images on the chart. Each image
represents an assigned amount of data, a 10" of a total range (or span) of the sensor and displays the
number from zero to 10.

|
The block ' Lor bar "_. icons can be used to change the images to abstract colour blocks or a bar chart.
ME | 4
Charts can be oriented either horizontally =] or vertically | ‘

To capture a live reading from the sensors click on the Store icon. r ‘The maximum number of stored
readings is 10.

Stored data can be sorted either by its sample | sz
number or by the maximum or minimum value of
each sensor.

[ A
Stop n logging, select the Sort Data icon
and choose how you want the data organised.

w1 Kom 1om Hom oo

s 1 1 B B B § § |
;11 1 7 ! |} |
) 1 I .

Sorted by sensors Max to Min ; 1N N .
2

N -
© Data Harvest Group Ltd. 11
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The amount of data assigned to each image or block can be altered by changing the range of the sensor
and/or its scale.

For example with a Light sensor:
e Ifitsrange is 0 — 1 k Lux (1,000 Lux) then each image will represent 1/10" of this range = 100 Lux. If
the range was 0 — 10 k Lux (10,000 Lux) then each image will represent 1,000 Lux.
o If the minimum to maximum scale of the 0 — 1,000 Lux range is reduced to 0 — 500 Lux then each
image will represent 50 Lux.

To change the range of a sensor either use New E or Sensor Config (Settings menu). Select the
sensors name, then Change Range. When the set range window opens select the required range, OK.

To change the scale of the sensor select Options @ Sensor Scale. Double click in the cell with the Min
and Max value and type in the new number, OK.

Qptions ] The name for the data channel can be changed in
| Background | Sensor Scale this window by double clicking in the cell with the
Image | Scale | Channel Name Min | Ma sensors hame and typing in a new name.
§ |=70 |Sound 400 |1100 The picture image can be altered by double clicking
e |- 1000 | Light 0 10000 in the cell showing the current image and selecting a
1 =140 [Temperature 300 [110.0 preferred image, OK
See page 53 on adding new images to those
available.
I Fiesst to default Min Max ] Select Image gl
[ Reset to Default Name ] : Image B o
a {-'y‘f, (= @ |
To reset to the original name or scale select the {JQ ﬂ“‘l b
data channel and select Reset to default Min Eeart) @ 3 il al
Max or Reset to default Name.

Select New E to set up a new recording.

Pictogram Wizard

Select a senzor to change its settings

| The range, picture or

Deselect the ——»11 ¥ 1 ot name of the sensor can

. Sound Temperature

tick next to also be changed from
any sensors this window.

from which 1

readings are

_ " select the sensor first
not required. L
/

L then the change option.

2

|

Change Picture

A

Pictogram Wizard

Orientation

Select Next to show the orientations ——pi
and display type of the chart or

select Finish.

© Data Harvest Group Ltd.
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[ A
To display the ‘real’ sensor value select the Values icon ] Select a data point (a box will highlight the
selection), the value and its unit will be displayed in the information window. Click on the Values icon
again to deselect.

DEm@n s E s e s

i Start/Stop Home Mew Options | Valuss | Pictogram | Block Graph Bar Graph [Horizontal | vertical Sort Data

{ Actual Value = 68 dBA )

Stored 1

Stored 2 3

Tackigpound | Sanco Sesle.

Sekect okins

al Lall Lol

To change the background colour of the chart select the
Background tab from the Options icon and select a new colour.

To label a data point:
¢ Right click in the chart area and select Add Text.

o A dialogue box will open. Type in the required text and OK.

¢ Move the curser over the data point you want to label, a highlight box will indicate the point selected
and the label will appear as a ‘ghost’ box.
]

Co (e ]

F [d | v
Stored 1 3 | | I._ | |
o 9 9
¢ Click and the label will appear.
Browim ‘“E”:ji't‘”
To move, edit or delete a label, right click on the label and select the appropriate function. Delsts

Move

Tip: Long labels are best displayed when the chart is displayed horizontally.

The EasyLog option

If EasyLog is selected from the Home screen, the graph window will open pre-set to record
sensor values continuously as a line graph until stopped. This makes it ideal for experiments
when the time of the recording is unknown.

Real Time Logging Wizard ®
EASYSENSE View, Q3 or 5 users: The New logging wizard will Er sl [ Easen : _
open, deselect the tick next to any sensors from which readings Qoo [ tuw—a¢— 1 Clickona
are not required. \,g:::: = tSensors name
= o change its
range

Click on the Start icon ﬂ to begin recording.

Logging will start with a time span of 30 seconds and
when it has elapsed the time span will double = rer
automatically. This will continue until the recording is

stopped by clicking on the Stop icon. Y

To change a sensors range select New E Select the sensor's name; when the set range window opens
select the required range, OK and then Finish.

Choose EasylLog when an X vs. Y graph is required (to plot the readings of one sensor against
another). Alter the X-axis to display a sensor (rather than time) — see page 31.

© Data Harvest Group Ltd. 13
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The SnapShot option

If ShapShot is selected from the Home screen, the graph window will open pre-set to

Click on the Start icon ﬂ to begin recording.
Click within the graph area to collect a sample. —

Click on the Stop icon !'] to stop data being
recorded.

If you click on the Start icon ﬂ again you will
be given the option to add the new readings
to the end of the existing data (if No is
selected the existing data will be deleted).

To change a sensors range select New [ﬂ

sensors from which readings are not required.

DO135 (6)

record sensor values on demand (manual sampling) with a bar graph display.

EASYSENSE View, Q3 or 5 users: The New logging wizard will open, deselect the tick next to any

Select the sensor’s name; when the set range
window opens select the required range, OK
and then Finish.

The Graph option

The logging wizard

Stage 1: Sensor selection
Deselect the tick next to any sensors from which readings are not required. If sensors have been
altered after start up, click on the Redetect button to identify the change of sensor.

== User Level 2 & 3

If Graph is selected from the Home screen, the graph window will open pre-set to record sensor
values against a chosen time span as a line graph display. The window will open with a real
time logging wizard from which the time span, interval between samples, start condition and
triggers for the recording can be chosen. When your selection has been made, click on Finish.

To change a sensor’s range, click on the sensor’'s name, when the set range window opens select

the required range, OK.

Click on Next.

Stage 2: Recording duration

Select the length of time that you want to record from the list.
Select the interval between samples being taken.

The number of samples will automatically alter when the total
recording time and the interval between samples are selected.
The range of recording times will vary according to which

data logger is used.

Real Time Logging Wizard X

Stlect the 108l recondng e
200m; ~ | FEAL TIME recoidng
B0
1 2econa ]
2 secords
§ cocondt
10 smcornds -
S the ntervsl betveeen sanples
25ms

Sy
100

Musnbee of sovrgle: 5

[ chack | Wt | [ Pk | [ Cwes |

If a very short recording and intersample  [EREEEEATEE

time are selected then the recording will Seectbe walecodegtine EEQ'T- ,I”V'E ret‘;?fdti,”g W][” Cha”%ertto
be in FAST mode. In this mode there will I — | 7ot I a combination ot very sho

) ) e recording and intersample times are
be no screen display of the data until the i selectedg

500ms

recording ends.

Note: If you wish to view fast data as it is being recorded then use Scope — see page 16.

Click on Next.

© Data Harvest Group Ltd. 14
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Stage 3: Select the Start condition as required.
This is used to set the condition required for the recording to start. The choice of start conditions and
triggers available on this page will depend on both the recording time selected and the data logger used.

Sebect §ta Condlion
C More
(=) Tragges on Lirved
il ngger
Charel Terpersnae 3 | & pten
T w00 O 2%
3 Trigger o Digtal Candition o
(o).

[ vbak |

B

[ famn | [ came |

E.g. start conditions for QAdvanced if
a FAST recording time is selected

DO135 (6)

Select St Conndlion

) More

(&) Trigger on Level
Chanesl

Terpematae

Abcree |00 ‘T

[ emsck |

[ Fean | [ e |

E.g. start conditions for REAL TIME

recording time

None - To begin recording as soon as you click on the Start icon m

Trigger on Level - To begin recording when the selected sensor is ‘above’, ‘below’, ‘rises above’ or

‘falls below’ a set value.

A

B

SET LEVEL

SET LEVEK

Above

To start recording
when the value from
a sensor is above a
set level.

Below

To start recording
when the value
from a sensor is
below the set level.

~

SET LEVE

A\
’/ SET LEVELl\

Rises above
Logging will not start
until the value from
a sensor rises up
above the set level.

Falls below
Logging will not start
until the value from
a sensor falls below
the set level.

Trigger on Digital Condition - to begin recording when a digital sensor, connected to input A or B, is

On, Off, Rising to On or Falling to Off.

Note: This option is only
available with certain
loggers when a FAST
recording time is selected.

SR

74

N

" |
o

"y -

N

Select any Pre Trigger requirements.

Note: This option will only become available if a FAST recording time with a trigger on level

or digital condition is selected.

Pre-trigger will allow a percentage of samples to be stored before the trigger

If Falling to Off is selected, logging will start when
an object has passed through the light beam

If Rising to On is selected, logging will start when
the first part of the object breaks the light beam

condition is met and the remainder to be taken afterwards.

For example, if 1,000 readings are to be taken and a 25% pre-trigger is selected,

FreTrigaer
(%) At Start

O 5%
O 50%
O 5%
O 100

249 readings will be taken before the trigger condition is met and 750 on and after

the trigger.

© Data Harvest Group Ltd.
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Note: Sufficient time must be allowed to elapse for the pre-trigger samples to be taken e.g. at a relatively slow
sample time of 100 milliseconds with 1,000 samples and a 25% pre-trigger, it will take 25 seconds to get to the
pre-trigger position.

¢ Click on Finish.

o Click on the Start icon m Recording will start when the start condition you have selected is met. The
recording will stop when the selected time span has passed.

Note: If you want to stop recording before the time span has passed, click on the Stop icon.n
If None was the selected trigger then the recording will start as soon as the Start icon ﬂ is clicked.

If recording REAL TIME, with a trigger on level selected, a ‘Waiting for Trigger’ message will appear in
the status bar (below the graph). When the trigger condition is reached the recording will begin.

If recording FAST with a triggered start, a recording data Fast Logaing

message will display (if there is sufficient time!) until the Fiecording Data

trigger condition is met. The data collected will download as

soon as the recording has finished.
The Scope Optlon == User Level 2 & 3

Scope models many of the functions of a simple oscilloscope. It displays ‘real-time’ plots
(as they occur) from the value of a sensor versus time. Unlike a graph that has a
beginning and an end, the scope trace is refreshed or ‘redrawn’ continuously as long as
data is being measured.

Make your selection from the control panel on the right hand section of the Scope window and then
click on the Start icon ﬂ to begin recording.

Once data has been recorded, it can be treated in the same manner as normal graph data e.g. the X-
axis altered from time Reading number.

Timebase

Note: Overlay and Pre-Log functions are not available. Interval: 50 us
Dwration: 12.8 ms Sl

Timebase

The duration / intervals that are available will depend on the method of Vitgss itz

connection to the computer and the type of interface connected. (s

&) Auto
The fastest speeds (with an interval shorter than 20 ms) require both direct O Single Shat
USB communication and an interface capable of fast logging. S
ngger Edge
(3) Positive ) Megative

For example:

e When an EASYSENSE Q Advanced is connected via Bluetooth the fastest Trigger Channel and Level
interval between readings available is 20 ms. If connected via the USB port, the Light v
fastest interval is 20 ps. -

Higher

e When EASYSENSE Advanced is connected via the serial port or a USB serial Levet 500 Is
adapter, the fastest interval between readings will be 20 ms.

e The fastest interval between readings available for EASYSENSE Q3, Q3+ or Fictiigeey P i
Q5 is 20 ms. For Q5+ the fastest interval will be 1 ms. O 0z @) 25

. . . O 503 O 75%

The timebase (interval between samples and duration) can be changed O 100%

during logging. Use Faster to decrease and Slower to increase the time

period between samples.

Duration 512ms | 128 ms | 256 ms | 51.2ms | 128ms | 256 ms | 512ms 1.28s 2.56s
Interval 20 ps 50 pus 100 ps 200 ps 500 pus 1ms 2ms 5ms 10 ms
Max. no. of sensors 1 2 4 4 4 4 4 4 4

© Data Harvest Group Ltd. 16
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Duration Roll mode | Roll mode | Roll mode Roll mode Roll mode

Interval 20 ms 50 ms 100 ms 200 ms 500 ms

When the interval between readings is 20 ms or slower, the timebase will be in roll mode. In this mode the

graph trace is redrawn continuously. When you click on Stop l"] the trace displayed will ‘freeze’ and the
data will become visible in the table.

If the interval between readings is 10 ms or faster, Scope will be in trigger mode.

Trigger Mode

e Normal —records a trace for the specified duration each time a specific starting condition (trigger) is
met.

e Auto - operates in a similar way to Normal, but if after a second the specified start condition is not
activated, a trace will be recorded. This feature is useful in testing that the trigger settings for an
experiment are correct. The trace will continue to be updated at a frequency of once per second.

e Single Shot - records one single trace and then stops recording automatically.

Trigger Edge
e Positive - the reading from a channel has to rise above a set value to trigger a recording.
¢ Negative — the reading from a channel has to fall through a set value to trigger a recording.

Trigger Channel and Level

e Select the Channel to be used for the trigger condition from the drop-down menu.

e Click on the Higher or Lower buttons to change the threshold value for the trigger. An orange dotted
line on the graph will mark the current level.

Pretrigger Position

e Allows a percentage of samples to be stored before the trigger condition is met and the remainder to
be taken afterwards. When logging stops a brown dotted line will mark the pre-trigger position on the
trace.

The Timing option
The diagram below shows a typical apparatus set up for use with Timing. This option is used to handle data
from switch-type sensors such as Light gates and Timing mats which only have two states, ON or OFF.

Connect the digital sensors being used to the interface. Measurements can be taken from either a single
sensor connected to Input A, or from two sensors connected to both Input A and B.

To perform calculations for Speed/Velocity, Acceleration, Distance, Momentum and Kinetic Energy, it is
necessary to enter the parameters used in an experiment. For example, to calculate speed from A to B, enter
the distance between the two digital sensors connected to A and B.

In this set up Light gates
are connected to Input A
and B on the interface
and are used to monitor
the movement of a cart
down a track. An
interrupt card is fixed to
the top of the cart. The
card will cut through the
Light gate’s infrared
beam.

© Data Harvest Group Ltd. 17
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When Timing is selected from the Home screen, the graph window will be pre-set to
record as a bar graph display against reading number. The window will open with a
timing wizard from which the measurements required, apparatus and its parameters,
and units for display can be chosen (the options available will depend on the level you

have selected to work at). When your selection has been made, click on Finish.

The Timing Wizard

= User Level 1 has a simple wizard to record Time or Speed at A, Time or Speed from A to B,

or Time from A to A (stopwatch).

Step 1 Step 2 Step 3 b
e Time atA Units and decimal places
from Ato B Units and decimal places
fromAto A . .
(e.g. Stopwatch) Units and decimal places
Step 1 Step 2 Step 3 a Step 3 b
e Speed atA Enter the Iengt_h of _th_e single Units and decimal places
interrupt card in millimetres
Enter the distance from the Sensor . .
fromAtoB at A to the Sensor at B in metres Units and decimal places

Step 1: Select whether you want to record Time or Speed. Select Next.

Step 2: Select whether you want to measure:

Time Speed

e atA e atA

e fromAtoB o fromAtoB
e from A to A (e.g. Stopwatch)

Select Next.

Step 3: If a Time option was selected then the next page will be units and decimals — see 3b. If
Speed was selected, the next page will be for entering the measurement required for the
calculation of speed.

3a:
Timing Wizard

Enter Parameters for Velocity from & to B

Distance from the Sensar at A to Sensor atB (Il |1

!

A B

X Timing Wizard X

Enter Parameters for Speed at & with Single Intenupt Card

Length of Singls Intsmupt Card ] [100 mm

[ <Bask ][ _mMew> | [ Frisn | [ cancel ]

[ <Back | _mMew> | [ Fish | [ Concel |

Velocity from A to B - enter the distance
between the sensor connected to Input
A and the sensor at Input B (in metres).
Click on Next.

© Data Harvest Group Ltd.

Speed at A - enter the length of the
single interrupt card that will pass
through the sensor connected to Input A
(in millimetres). Click on Next.
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EASYSENSE software
3h: Select the number of decimal places and the units for

the display of calculated data from the drop-down
menus.

Select Finish.

DO135 (6)

Enter the Urits and Decimal Places for the calculated results

Decimal Places

Time

Units

Click on the Start icon. When a signal change from the digital sensor/sensors is received, the
timing measurement will automatically be entered into the table and graph. The vertical axis scale

automatically adjusts to match the largest value collected.

88 User Level 2 and 3
The pages in the Wizard will vary according to the choice
made in the previous step.

Step 1: Select how you want to record the data. Click on Next.

Step 2: Select whether you want to measure at A, at A or
B, from A to B, at A then B, etc. Click on Next.

Step 3: Select the apparatus/interrupter you will be using in
the experiment. Click on Next.

Step 4: Enter the measurement of the apparatus/interrupter
required by the calculation. Click on Next.

How do you want to recard the data?
O Time
O Distance
(* SpeedVelocity
() Acceleration
) Momentum and Kinetic Energy
O Raw Times

Timing Wizard X

Mext » ] [ Finish ] l Cancel

Step 5: Select the number of decimal places and the units
for the display of calculated data from the drop-down menus.
Click on Next.

Step 6: Select, if required, to display any of the columns
of data used in the calculation of the final set of data.

Acceleration at A= Change in Velocity Speed A2 — Speed A1

Timing Wizard X

Select the columns to display

[] Speed &l
] Speed sz
[ Time at A1

Time Taken Time A1 to A2

Note: The option to show these columns are also available from
Show Columns in the Settings menu.

[ Time at &2
[ Time A1 to A2

Click on Finish.
LEVEL 2 and 3 choices are:
Measure User
Level Interrupter Measurement
Time | atA 1,2, 3 - -

fromAtoB 1,2, 3 - -
fromAto A 1,2,3 - -
e.g. Stopwatch
atAorB 2,3 - -
at Athen B 2,3 - -
period at A 2,3 - -
e.g. Pendulum

© Data Harvest Group Ltd. 19
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Speed/ | atA 1, 2, 3 | Single interrupt card - length of card (mm)
Velocity
2,3 | Double interrupt card - segment length (mm)
2,3 | Picket fence - fence pitch (mm)
- calculation increment
2,3 Pulley - none
from Ato B 1,2,3 - - distance from A to B (m)
atAorB 2,3 | Single interrupt card - length of card (mm)
at Athen B 2,3 | Single interrupt card - length of card (mm)
Distance | atA 2,3 | Picket fence - fence pitch (mm)
- calculation increment
2,3 | Pulley =
Acceleration | atA 2,3 | Double interrupt card | - segment length (mm)
Picket fence - fence pitch (mm)
- calculation increment
Pulley - none
atAorB 2,3 | Double interrupt card | - segment length (mm)
from A to B 2,3 | Single interrupt card - length of card (mm)
at A then B 2,3 | Double interrupt card | - segment length (mm)
change from A to B 2,3 | Double interrupt card | - segment length (mm)
Momentum | at A 3 Single interrupt card - length of card (mm)
and Kinetic - mass of object passing through A (kg)
Energy
3 Double interrupt card | - segment length (mm)
- mass of object passing through A (kg)
3 Picket fence - fence pitch (mm)
- calculation increment
- mass of object passing through A (kg)
3 Pulley - mass of object passing through A (kg)
atAorB 3] Single interrupt card - length of card (mm)
- mass of object passing through A (kg)
- mass of object passing through B (kg)
fromAto B 3 - distance from A to B (m)
- mass of object passing through A (kg)
at A then A 3 Single interrupt card - length of card (mm)
- mass of object passing through A (kg)
change from Ato A 3 Single interrupt card - length of card (mm)
- mass of object passing through A (kg)
at A then B 3 Single interrupt card - length of card (mm)
- mass of object passing through A (kg)
- mass of object passing through B (kg) |
change from Ato B 3 Single interrupt card - length of card (mm)
- mass of object passing through A (kg)
- mass of object passing through B (kg)
Raw Times atA 3 - -
(interrupt edge
times)
atAorB 3 - -

© Data Harvest Group Ltd.
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Measurements

Measurement at A
Uses one digital sensor connected to Input A. Timing starts when the signal from Input A changes (ON)
and stops when the signal reverts back (OFF).

o If Light Gates are used with a single interrupt card, the time measured is for how long the card
took to pass through the sensor.

e For a Push Switch it will be the length of time that the switch is kept depressed.

e For Timing mats it will be the length of time someone stands on the mat.

Measurement from A to A

E.g. stopwatch

Uses one digital sensor connected to Input A.

Timing will start when the signal at input A changes (ON) and will continue until the signal
at A goes OFF and then ON again.

Period at A
E.g. pendulum

Start the pendulum swinging, when it is moving
freely click on the Start icon.

Timing will start when the pendulum first passes
through the Light Gate. When the pendulum
passes back through, it will ignore the second
signal change and will stop at the third change
(when the pendulum arrives back at the Light
Gate). The time shown will be for a complete
period.

Point at which
the pendulum
starts and stops
the recording

Measurement at A then A
Uses one digital sensor connected to Input A. Time will be measured for a single interrupt card
passing through a Light Gate (A1), and then returning back through (A2). E.g. for rebound collisions.

Change from Ato A
Uses one digital sensor connected to Input A. The measurement will be for the change in value from
A2 to A1 e.g. for a single interrupt card passing through a Light Gate and returning back through.

Measurement from A to B

Uses two sensors connected to Input A and B. A measurement is taken for the time an object takes
to travel from the sensor at Input A to the sensor at Input B. Timing will start when the signal change
at Input A is detected and stops when the signal at Input B changes.

Measurement at A then B

Uses two sensors connected to Input A and B. Three measurements are recorded of an object
travelling from the sensor at Input A to the sensor at Input B. The measurements are:

1. Time to pass through Sensor A

2. Time to pass through Sensor B

3. Time to travel from Ato B

Measurement at A or B

Uses two sensors connected to Input A and B. A measurement will be taken from whichever sensor
detects the change in signal level. The measurement will be the time to pass through either sensor A
or sensor B.

© Data Harvest Group Ltd. 21
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Change from Ato B

Uses two sensors connected to Input A and B. A double interrupt card is used to measure the
acceleration at A and then at B. The measurement shown will be the change in acceleration (Acceleration
at B — Acceleration at A).

Distance at A

Use the Picket fence or Pulley, with a Light Gate connected to Input A, to measure the distance moved.
Distance is calculated using the step size of the Data Harvest Pulley, or the pitch length of the Picket
fence. Each time a new gap in the Pulley or the pitch of the Picket fence is reached; the distance moved
is known.

Raw Times

Timing is usually started when the solid black part of an
interrupt card blocks the infrared beam on a Light Gate and
changes the logic level from 0 to 1. When the clear part of
the card is reached, the infrared beam is restored and its
logic state changes back to 0 and the event time is taken.
Raw times show the logic levels as 0 and 1 values with the
time of the event.

° (]
Apparatus o e
Single Interrupt card °
Measure the solid part of the card that will pass through the Light
Gate (mm). Speed is calculated using the length of the interrupt ¢

card divided by the time taken for the card to pass

Double Interrupt card

The two segments of a double interrupt card
must be equal in width. Measure the solid part
of the card that will pass through the Light
Gate (mm).

E.g. Average acceleration can be measured using a single
Light Gate with a double interrupt card. Acceleration is

Time taken calculated using the length of the segments on the double
for velocity interrupt card.
to change

Acceleration = Change in Velocity =
Time taken

V, {Lenqth of seqment} -V, {Lenqth of seqment}

Time Time

Time taken

Picket fence

The picket fence is a multi-segmented

interrupt card so a sequence of

measurements will be taken.
| |
< | >|

Measure from the start of one black edge to the start of the next black edge.
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To improve the accuracy of readings, a calculation increment can be applied to average the times
over fewer pitches.

Note: A calculation increment (of more than 1) will result in fewer measurements than the number of pitches on a fence might indicate.

Pitch length (1) Suggested calculation increment
60 mm or more
50 mm
40 mm
30 mm
20 mm

*10 mm 5-8

AIWININ[=

*Note: If a picket fence with a pitch length of 10 mm is used with buggy type investigations (which produce slower times
than gravity investigations), the times can be averaged over less pitches so the calculation increment could be reduced to 5.

When a Picket fence is used to measure speed or acceleration, the measurements shown are for
instantaneous values i.e. it took this amount of time to travel this distance and the acceleration
was.

Spoked Pulley
The measurements for the Data Harvest Spoked Pulley are pre-defined.

The spokes on the pulley can easily interrupt the Light Gates beam
to create false results. Wait until all is ready before you click on the
Start icon.

When a Spoked Pulley is used to measure speed or acceleration,
the measurements shown are for instantaneous values i.e. at this
distance, the speed was.

= User Level 1 and 2

The Counting option

Menu bar — e e . _ < <€— User Level icon
Toolbar —p- B MM P E| F) [F1[E ) X
K Batiie Pem P Cplirs Peligen Sk i e Gt [ | v s |
Information — a+8=14
A CasedE] — Double left click in the area

above the chart or right
click within the graph area
to enter a Title

5| Title

'
"
w
-
@
-
-
™
@
H

This option is used to count events using switch-type (digital) sensors such as Light gates or Timing mats
which only have 2 states ON or OFF.
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The chart type can be changed to images W or a colour block E ‘ oriented either horizontally E or
vertically |

Select the Sums icon b ‘ to cycle through simple calculations based on the counting data (A + B, A - B,
B — A, Difference), which will be displayed in the information window.

Select New E] to set up a new recording.

Pictogram Wizand E|
Select a sensor to change its zettings
?
Deselect the P L= i
tick next to o —
any sensors
from which 1
readings are ™ .
gs ™~ Select the sensor first then the change
not required. :
9 __1— option.
«—
Pictogram Wizand g‘
Orientation
T O Horizontal @ Vettical
Select Next to select the orientations ——» i e
and display type of the chart or
select Finish. E E
O Pictogram (%) Block. O Bar

To change the name of a data channel select the sensor then Change Name. Type in a new name, OK.

To alter the picture image first select Seloct Image ®
the sensor then Change Picture. Select Image
the preferred image, OK. P— / N ~
N I
See page 53 on adding images to those available. L — L
[ : : ? =
a.\::---: S Sale _EIK -_Eancal

4 Colous
-Ill -Ill -Ill
5] [s] 5]

To change the background colour of the chart select the Options
icon and select a new colour.

.Ill .I|I .I||
] [5] (5]

[ Canend
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The Graph window

EasylLog, SnapShot, Graph, Scope and Timing use the graph window to display and analyse readings.

J Data Harvest EasySense Software

Menu bar —»| i et ooy Selings dcalpss Took b — .. 4— User level
Toolbar —» ] [ [F I NN SR AT
LSIp Hoind bow  Overby Optors Vakae Inteyal Differerce Gradent acea Nobs |
Information toolbar —¥%: |
Sound (dBA) Light {Ix) Temperature (°C)
Data value boxes ——»
Poas <————— Double left
Window dividers 4 click in this
area to enter
1o a Title
Y-axis —»
mo+
Left click in the area 17
left of the graph to — ¥, - Show or Hide Charels

alter the channel ] Zoom In

displayed. olick e

o4

Auto scale graph Min Max
Auto scale graph O o Ma

nght CIiCk Ieft Of the Auto scale channel Min Max
graph area to alter » Autn scale channs! 0 to Max
the sensor settings Predict
(name, axis limits)
S0 add Text
A Title
Status bar —» T T T

The graph area X-axis Left click below the Right click below

graph area to alter the graph area for

the choice displayed the X-Axis options

The Toolbars

Overlay - adds
a new set of
data without the

Click on this ; Values - to Difference Area - calculates
. previous set )
icon to return being erased find the value between the area under a
to the Home 9 at a selected the data at section of the
window (Level1,2&3 point two points graph
Graph, Snapshot
(Level 1,2 & 3) and EasyLog) (Level 1,2 & 3) (Level 1,2 & 3) (Level 3 only)

N

| T l
DEARME AL ARANAL

: Start/Stop Home Mew Owerlay Options Walues Interval Difference Gradient Area MNotes

I I I I I I

Start or Stop icon New - to set Options - to Interval - find Gradient - Notepad for
up a new change the the time calculates the entering
(Level 1,2 &3) . R . A

experiment way data is elapsed rate of change information

(Level 1,2 & 3) displayed bdet\tNeen. t\;VO (Level 2 & 3 only) aboqt an t

(Level 1,2& 3) ata points experimen

(Level 1,2 & 3) (Level 1,2 & 3)
The Toolbars can be positioned at the top, bottom or left or right side of the graph. :
To move, position the mouse pointer over dotted line to the left of the toolbar, when :
it becomes a 4$>symbol, click, hold down and drag to its new position. ’ :

: Start/Stop
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With some logging options, the table area will
automatically be exposed. If not, select Show DB RARMD S B CE
Table from the Display menu. If it is not o
selected, then the graph will automatically fill | l

the window. ——

The table can still be exposed in this Window divider —p
mode by dragging the window divider to
the right i.e. position the mouse pointer |
over the window divider to the left of the The table area {—— The graph area
screen, when it becomes a <1+symbol, ml

click, hold down the mouse button, and
drag to the right to expose the table
area.

\4

Recording data

! To begin recording, simply click on the Start icon.
Start/Stop

n During logging the Start/Stop icon will show a red square.
Click on this icon to stop data being recorded before the selected duration has passed.

Start/Stop

If you want to repeat the last experiment (with all of the settings the same) simply click on the
Start icon again.

m If you want to graph a new set of data, without the previous set of data being erased, select
: Overlay before you click on Start. (Not available in Scope or Timing).
Civer lay

To set up a new investigation e.g. to change the duration of a recording in Graph, or to identify
a change of sensors or change a sensor’s range, select the New experiment wizard.

=

To go from one option to another e.g. from EasylLog to Snapshot, select the Home icon.

Selecting Data

To select individual readings: -
Click on the reading in the table or on the graph. The reading will be highlighted in the table and marked
with a cursor on the graph.

Al sandige) ¢ ]

To deselect readings:
Click with the left hand
mouse button in the area
above the graph.

To select more than one reading in a i Gl ot 4

series: -

e Click on the first reading of the series,
hold down and drag the mouse to the
last reading or

o Click on the first reading of the series,
hold down the SHIFT key and click on
the last reading.

The selected readings will be
highlighted in the table and marked by
a box in the graph.
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To select readings that are not in series: -
Hold down the CTRL key and click on each
reading or point in turn.

]
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The selected readings will be highlighted in the
table and marked with cursor lines in the graph.
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Use selection == User Level 2 & 3

To display a selection of the recorded data, select the data required from the table or graph area (so
it its highlighted). Click on Use Selection from the Edit menu and the graph will alter to use the
selected data only.

If you save while the selected part of the data is displayed, then only the selected data will be saved,
(not the full data set).

Selection Wizard ==& User Level 2 & 3

Selection Wizard from the Edit menu can be used to select Auto Selection X
readings at specified intervals. SRR 1

End with reading 20
Type in the first and last reading of the selection and the interval Inerval 0

between the readings (e.g. every 10" reading). Click on OK and the
selected readings will be highlighted in the table and graph.

[ Use the selection

If the ‘Use the selection’ box is ticked the graph will automatically alter
to display only the selected data.

Previous Selection === User Level 2 & 3
Use Previous Selection from the Edit menu to revert back to the previous selection.
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There are a number of tools built into the graph window to allow the analysis of captured data.

Note: Some of these tools will not be available when the X-axis is a data channel i.e. Interval, Difference, Gradient

and Area.

Click on Analysis in the menu bar to open the Analysis menu.

values
Interval

Difference

Analysis menu

at Users Level 1 e

Yalues
Interval
Difference

Gradient

Show Statistics

Yalues
Interval
Difference
Area

Gradient

Show Statiskics

Analysis menu
at Users Level 2 @@

Analysis menu
at Users Level 3

Values

Select the Values icon and move L
the mouse pointer into the graph 'F ]
area. A cursor will appear which can £

be moved around the graph using

the mouse.

Position the cursor at the point where
information from the graph is needed. The
corresponding value will be shown in the data
value box and highlighted in the table. The
information box will indicate the time of the
selected data point. “

If the X-axis is a sensor, then cross hair cursor
lines indicate what the value from the sensors
would be if they crossed at the cursor point.

Click on the Values icon again to deselect.

Interval

Select the Interval icon. Click on R
the first point on the graph, hold A
down and drag the mouse to the

second point 65
A box will be drawn around the section B - =" re—— =~

of graph and highlighted in the table. M= T —
The information box will display the time of
the first point, the time at the second point
and the interval between them.

u ==
=]

Click on the Interval icon again to deselect.

I
i

Click in the title area (just above the graph PR | o e
area) to deselect any selected readings. -
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Difference

Select the Difference icon. Click on [
the first reading to be used in the r ‘
comparison, to give a fixed cursor at
that point (shows as a brown or 3.86 «— Difference in the readings
black line in the graph and table). e
Click on a second reading. B

Note: Alternatively click on the first reading
and then select the Difference icon.

The values in the data boxes will show the ‘ ™ e
difference between the data at the two points. '

While Difference is still selected it is possible
to repeatedly select a second reading to B
compare with the first. T T

1% Reading 2" Reading

Click on the Difference icon again to deselect.

Gradient = User Level 2 & 3

This feature calculates the rate of r\‘
change of data in the vicinity of the :
cursor. .

When the graph line is horizontal the gradient

is zero and values are not changing. A positive
gradient shows that values are increasing — the ol el I -
larger the gradient, the faster the change. [ ' ) = \
The calculation is performed over two points \ {/T\ 7\ [/aX! /a\\ |
either side of the cursor. ol —\ A A S A __.4'__.;_

Click on the Gradient icon and a vertical cursor
with a small line will appear to indicate the
slope of the graph for whichever data channel is
currently selected on the Y-axis. The gradient
value for all data channels will be shown in the e ———
data value boxes.

Click on the Gradient icon again to deselect. A manual Best Fit line can be used to calculate the gradient
between two points — see page 40.

Area & User Level 3

This feature is used to calculate and r
display the area under a chosen 1
section of the graph. I

The calculation for area is performed on the
data from all channels. The units correspond
to the product of the Y and X-axis.

Click on the Area icon. Click on the first
reading, hold down and drag the mouse
across the appropriate section of the graph.
Shading lines will mark the section under the
graph for whichever data channel is currently
selected on the Y-axis. The values for area
will be shown in the data value boxes.

Click on the Area icon again to deselect. Click in the area above the graph to deselect any selected readings.
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Show Statistics = User Level 2 & 3

Show Statistics calculates and displays statistical information about the data collected from the data
channel currently selected on the Y-Axis.

Select the appropriate data channel on the Y-Axis. Select Show Statistics from the Analysis menu.

¢ Max (Maximum) — the highest value reading

o Mean — the arithmetic mean.

e SD (standard deviation) — the scatter of a seriesof | baw 367
measurements about their mean value

e Min (Minimum) — the lowest value reading

If only a part of the original graph is selected (e.g. byusing | e Mean: 216 -50: B.02
Use selection) then the statistics will be calculated using the —————— BT
data from only the selected part of the graph. | 7T [

To switch statistics off, deselect Show Statistics from the Analysis menu.

Displaying data

Data Value boxes

The value recorded by a sensor will be displayed in a data value box. The colour used in a data value
box corresponds to the colour of the plotted line and the axis label on the graph. Each data channel is
allocated a different colour i.e. channel one is red, channel two is blue, and channel three is green.
These colours relate to the channel of data, not the type of sensor or the input number e.g. if
Temperature sensors are used connected to Input 2 and 4 on the interface, they will be allocated to
the first available data channels, Channel 1 (red), and Channel 2 (blue). See page 32 to change the
channel colours.

If ‘Example data’ is selected from the Interface menu, simulated data Sensor 1 (%)
will be available. The data value box will be labelled as Sensor (%).

The window divider can be used to resize the data value boxes i.e. 82 . 1 4

position the mouse pointer over the window divider under the data

boxes, when it becomes a - symbol, click, hold down and drag <4— Window
divider

downwards.

Axis display

Click with the left hand mouse button in the space to the left of the graph area to alter the data ~i
channel displayed. Subsequent clicks will cycle the Y-axis through all the data channels open.

Click with the right hand mouse button in this space to open the Sensor Setting tab option
(see page 32).

Click with the left hand mouse button in the space  r e ;
available for whatever is currently displayedonthe =~ """ """ TTT
X-axis.

1. Time - select between:
¢ Elapsed Time — from zero until that point in seconds [ Time (s) ],
e Elapsed Time in days, hours, minutes and seconds [ Time (ss), (mm:ss), (hh:mm:ss),
(d.hh:mm:ss) ]. =
e Absolute Time - the time & date from the start of recording until that point [ Absolute
Time (hh:mm:ss), (d.hh:mm:ss) ].

below the graph area to cycle through the options p . s 1 i

2. Sensor - cycle through the data channels available.

3. Reading Number - no choice is available
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Click with the right hand mouse button in the space below the graph area to open the X-Axis tab options.
From this tab select whether you would like Time, Reading Number or Channel (e.g. sensor) displayed on
the X-axis.

DISplay OptlonS Murnber of Graphs

The options t_o alter_the overall graph display are a\{ailable Graph type

f either from Display in the menu bar or from the Options s
icon.

Sensor setkings

Note: Other display choices, e.g. Show or Hide Channels, Zoom, Grid
Title and Auto scale, which apply to an individual graph, are Colour
available by a right click in the graph area. See_page 33. o Tabie

The Display menu in the graph
window - Users Level 2 and 3

Number of Graphs o8
Select the radio button next to the number of graphs that you T e
want displayed in the graph area. o

ey

Graph type
Use this tab to customise the appearance of the collected data in the graph e.g. the graph type, thickness
of line, point style and grid.

Options =

Choose whether you want to display readings as a line or [anber f s | G910 Xt | Sensorstngs | G
bar graph. B T e

s B ‘ None ® MNone
%

e IfLine Graph’ is selected, then individual readings
are by default joined by a line. There is a choice of
four different thickness of line or no line (none). The
readings can be marked by a choice of symbols or oo
remain unmarked (none).

-
¢ B O

e If Bar Graph'is selected then readings will be shown
as bars of colour

Show Grid
If a grid is selected then a faint grating is marked on the graph. There is a choice between a fine and
coarse grid.

Options =

X-Axis
From this tab select whether you would like Time, Reading
Number or Channel (e.g. sensor) displayed on the X-axis.

| Number of Graphs | Graph type | %43 | Sensor settings | Colour |

Select X Ais
@ Time
*) Readng Number

Time - the selected time span is used for the X-axis.

*) Channel

Reading Number - the X-axis will be set to the number of
single readings taken from a sensor, without any regular time
interval between them. This axis is used for Snapshot data.

Channel - the X-axis will be set to use one of the data
channels e.g. a sensor. This axis is used for an X vs.Y plot. (bt [otimen]

Note: To alter the data channel shown on the X-axis, click with the left hand mouse button in the space below the
graph area to cycle through the data channels.
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Sensor settings o LW | SN
From this tab the name and limits displayed for a data [cer sG] Gophape [ St [co

Double click in cel to alter the name or limits

channel or sensor can be altered. - |
|

Channel Name Min Max

Sound 400 1100
Normally the full scale of a sensor is displayed on an axis T o o
e.g. the scale for a Temperature sensor will show a minimum
of -30 to a maximum of 110°C. If the scale of an axis is too

large, the minimum and maximum limits displayed can be }

altered e.g. reduced to a minimum of 10 to a maximum of

° Reset to Default Name Reset to Default Min Max I
50 C. On all Sensors:
[7] Display Decimals
The name used for a data channel can also be changed e.g. Lo ) Coms ]

from Temperature to Room Temperature.

Name: Double click in the cell with the data channel/sensors name and type in the new name. The
altered name will be marked by an asterisk.

Minimum & Maximum: Double click on the cell with the Minimum or Maximum value and type in the new
number. The altered number will be marked by an asterisk.

* Room T emperature “0.0 *40.0

To reset to the original name or scale, click to select the data channel and select Reset to Default Name
or Reset to Default Min/Max.

Click on OK to finish.

Note: If the value from a sensor being recorded rises above the maximum or falls below the minimum limits that have
been set, Graph will not be able to accurately display the true value.

Display Decimals - Used to switch decimal numbers on and off from the display. If Display Decimals is
not selected, the reading will be rounded up to a whole number.

Note: While in Timing, the number of decimal places displayed can be altered - see Change Units on page 44.

Options

CO|OUI’ || | Humber of Graphe | Gragh tyes | XAwia | Sersor wetirgs | Dol
From this tab the colour used by a data channel can be altered. e Cos
Dol che o the Channed tn change &3 daplay coleur
Sound
Double click on the data channel/sensor name. A colour palette e
will open. Select the colour required and click on OK.
Faar ciery
Click on OK to finish. - EmmEEm
EEEEEEEN
EFEEEEEN
EEEEEEENR
(i mEEENTE
oK Cancel
= .
[ : [
Defne Custom Cokors 5
Individual graph choices —
Some display options i.e. Show or Hide Channels, Zoom, Auto scale
. : o .« . Z I
and Title, are applied on an individual graph basis rather than to all e
graph; dl_splayed. These are available by a right click in the graph area soom Off
of the individual graph.
Auto scale graph Min Max
Auto scale graph 0 ko Max
Auto scale channel Min Max
Auto scale channel 0 ko Max
‘Right click’ ——» ororint
context menu rese
Add Text
Title
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Show or Hide Channels
The data from a channel or sensor can be hidden from view.

Right click in the graph area and select Show or Hide Channels. Deselect the tick next to any sensors
or channels you want to hide.

Example: =
In this example two EERADE S DO
graphs are open. Show e '
or Hide Channels has ‘

been used to deselect

one of the sensors from
each graph.

A

A

Zoom
An area of the graph can be magnified so that it can be seen in greater detail.

Right click in the graph area and select Zoom In.

Position the mouse pointer at the top corner of the area
to be magnified. Click, hold down and drag the
rectangular box over the area to be magnified. Release
the mouse button to show the magnified area.

To expand this magnified area further, right click, select
Zoom in and repeat the above.

Right click and select Zoom Out to zoom out by one step.

Right click and select Zoom Off to return to the original
graph.

Auto scale

This option scales the Y-axis by using the values of the data collected. Right click in the graph area
and select one of the four choices. The graph will automatically be adjusted.

Auto scale graph Min Max — applies the Auto scale to all the channels of data on the graph using the
minimum and maximum limits of the data.

Auto scale graph 0 to Max— applies the Auto scale to all the channels of data on the graph using a
minimum value of zero with maximum of the maximum limit of the data.

Auto scale channel Min Max — applies the Auto scale to whatever data channel is currently selected
on the Y-axis using the minimum and maximum limits of the data.

Auto scale channel 0 to Max - applies the Auto scale to whatever data channel is currently selected
on the Y-axis using a minimum value of zero with maximum of the maximum limit of the data.

Deselect to return to the original scale.
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Title

To add a title to a graph, either right click in the graph area and select Title or double click with the left
mouse button above the graph area.

Type in the text for the title. = o

The Table display

Show or Hide Channels g]
Sensors/channels columns can be hidden from view. Right click in the ElSard
table area. Deselect the tick next to any sensors/channels you want to Light
hide Temperature

The width of the columns in the table can be increased or decreased.
Position the mouse pointer over the line in the column heading. Click, hold
down and drag to adjust the width.

Line
1
¥

Light [lx] ~ Temperature ['C]  Comment

The Comment column

Once some data has been collected, you can add text to the Comment column in the Table. Double click
on the relevant cell in the Comment column. A dialogue box will appear for you to type in text or numbers
from your keyboard.

To Edit, double-click on the comment to re-open the dialogue box and alter as required.

Using Tools on the data Smecing et
) ] Motes Pre-log Function
Click on Tools in the menu bar to open the .
Test Mode Post-log Function
Tools menu. _
Tools menu at Best Fit
Note: Some tool options i.e. Predict, Delete Predictions Users Level 1 a» els
and Add Text, which apply to an individual graph, are Test Made

ilable b ight click in th h .S 41.
available by a right click in the graph area. See page Tools menu at -=
Users Level 2 & 3 @ @
Notes

r | Select Notes from the toolbar or from the Tools Notes X
| menu to open the notes window, which has basic e e senears gt o e
text editing facilities. The text written in this window e Mo ]
is automatically saved in a data file. Use this window
to write notes that would be useful when setting up
the experiment, information about how the data was
collected, or your conclusions to the experiment.

Test Mode

Select Test Mode from the Tools menu to test that your sensor is operating correctly. The current value
from the sensor will appear in its data value box.

The Test option will be active until it is deselected or a recording is started.

Smoothing
Used to ‘even out’ the data of a selected line by applying a moving average.

Smooth Level

Select Smoothing from the Tools menu. Select the data channel that you want to Select the Chiarnel 1 Smaoth

smooth from the drop-down menu. Click on the > button to smooth or < to reverse -
the process. The smooth level advances at one unit at a time for the > symbol :
and 5 units for the >> symbol. Click on OK when the smooth level is correct.
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Pre-log or Post-log Functions == User Level 2 & 3

Functions are mathematical operations that can be applied to data. Functions can be applied to data as it
is being collected using a Pre-log function or after the data has been collected using a Post-log
function.

For example: Select Pre-log function from the Tools menu to show both Velocity and Distance data
from a Motion sensor as logging progresses. There maybe a slight delay (in most cases unseen) between
collection of data and presenting the pre-log data on the screen e.g. 3 data points are needed before
calculation of velocity can commence (acceleration would need 5 points).

Note: Pre-log functions are not available in Scope.

For example: Select Post-log function from the Tools menu to create a new set of data from data that
has already been collected e.g. calculates Power from Voltage and Current data.

e Select whether you want to use a pre-set function or formula to create the set of data.
0 Pre-set functions are described in words to make creating the data set simpler.
o Formula - presents mathematical formula for generating data.

Pre-set functions:

1. The top menu indicates the subject/topic area, click
on the down arrow to view the options available P
and select the subject area from the drop-down list. Elesicy v

Resistance -

Select a Preset function or a Foimula

The lower menu will indicate the function(s)
available within the selected subject area, click on
the down arrow to view the options available and
then select the functions from the list.

1 low resistances set decimal places to 3

s olts is ', make Multiplier = 1000.
is mé and Yalts is m, make Multiplier = 1

The white panel at the bottom of the window gives
mforma’qon about whgf( the f_unctlon yV|II b(_a
calculating, what additional information will be

needed for the calculation, units, etc. Click on Next.

2. Select the data channel(s) to be used as the source. Click on the arrow to reveal the list of sensors
connected, it is presented in the order of the connected sensor ports. With Post-log functions the
list will include any derived data channels. Click on Next.

3. Enter the details for the new set of data. A default
name and units maybe already entered but they T e
can be edited. Alter the number of decimal places iz P
to be displayed if required. Ui i Desinafeces |2
Channel limits Paramet ters

Select whether the axis limits of this data should S e i
either expand to fit or use manual limits. Cranmeltay |12

Expand to fit - when the recording has finished, i e on Ul ey o Fro e et g

. . . . en Current is A and Yolts is V, make Multiplier = 1.
the axis will automatically redraw if data has e e e Honees .

“when Currentis mé and Yolts is m, make Multiplier =1

exceeded the limits taken from the original data.
Manual — use the limits of the axis as specified
in the minimum and maximum boxes.

Note: The default value is based on the default limits of the first source channel used in the calculation. If
the maximum value calculated by the function is less than the source channel limits, apply Autoscale (see
page 33) to find the limits of the calculated data.

Enter any parameters required e.g. type in a multiplier, constant or scaler. Numbers can be
negative or positive (make sure there isn’t a space between the + or — sign and the number). The
action of the parameter is often indicated in the white panel. Click on Finish.

4. |If you are using a Pre-log Function, click on the Start/Stop icon. Data will be calculated and
displayed on the graph and table. Values will not be displayed in the data values boxes during

logging.
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SUBJECT

FUNCTION

INFORMATION

Electricity

Resistance

Calculates resistance from Voltage and Current data. Current
sensor values can be in units of A or mA, Voltage in mV or V.
Identify the sensor’s units and select the correct multiplier (shown
in the white information box). For low resistances set decimal
places to 3.

When Current is A and Volts is V, make Multiplier = 1
When Current is A and Volts is mV, make Multiplier = 0.001
When Current is mA and Volts is V, make Multiplier = 1000
When Current is mA and Volts is mV, make Multiplier = 1

Power

Calculates power from Voltage and Current data. Current sensor
values can be in units of A or mA, Voltage in mV or V. Identify the
sensor units and select the correct multiplier (shown in the white
information box).

When Current is A and Volts is V, make Multiplier = 1

When Current is A and Volts is mV, make Multiplier = 0.001
When Current is mA and Volts is V, make Multiplier = 0.001
When Current is mA and Volts is mV, make Multiplier = 0.000001

SUBJECT

FUNCTION

INFORMATION

Motion

Velocity

Velocity, calculated from position, distance or displacement data (first
derivative) as dx where x is the distance data and t is the time data.
dt

Enter the units as appropriate e.g.

Linear Motion — units (m) — m/s; (cm) — cm/s; (mm) — mm/s; (in) —
in/s.

Pendulum, units (deg) — deg/s.

Acceleration from

position data or distance

data

Acceleration calculated from position or distance data (second

derivative) as d’s or d°6.
df  df?

Enter the units as appropriate e.g.

Linear Motion — units (m) — m/s/s; (cm) — cm/s/s; (mm) — mm/s/s; (in)
—in/s/s.

Pendulum — units Angular acceleration — deg/s/s.

Acceleration from
Velocity data (first
derivative)

Acceleration calculated as the first derivative of Velocity data (linear)

Enter the units as appropriate e.g.
Linear Velocity [m/s] — Linear Acceleration [m/s/s].

Angular Acceleration
from Angular Velocity
data

Angular Acceleration calculated from Angular Velocity data (first
derivative)

Enter the units as appropriate e.g.
Angular Velocity (revs/s) — Angular Acceleration, units revs/s/s
Angular Velocity (rads/s) — Angular Acceleration, units rads/s/s

Displacement from a
reference point

Displacement = the distance from a reference point.
The distance value of the reference point is subtracted from the
distance data to give the displacement.

E.g. with an oscillating spring, the ‘reference point’ would be the distance
value of the centre of the oscillation. The displacement required is the
displacement from the centre of oscillation.

Pendulum - Linear
Displacement

Calculates the linear displacement along the arc of the pendulum
oscillation. It is calculated from the midpoint of the oscillation.

Assumption; the angles are small (less than 20°) and sinR = R in radians

Displacement from
Velocity

Calculates the displacement from Velocity data.
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Energy Gravitational Potential G.P.E. = E; = mass (kg) x acceleration due to gravity (m/s/s) x
Energy (G.P.E.) distance (m).
Use to calculate the change in potential energy of an object between
two points in a gravitational field.
E.g the GPE gained when a ball bounces to a certain height above the floor.
AE, =mxgxAh
Kinetic Energy Kinetic Energy = [0.5 x mass (kg)] x velocity”
Pendulum — Potential Calculates the difference in the potential energy of the pendulum bob
Energy between the centre of the oscillation and any other position in the
oscillation.
The angular displacement data must be in radians before this
function is used (see the Conversion pre-set functions).
Spring — Elastic Calculates the change in the elastic potential energy of the spring as
Potential Energy a result of the displacement of the spring/mass system from the
midpoint of the oscillation.
Calculated as "2Fx (Joules)
General Tare Use this function to subtract an offset from a sensors readings

(typically used to zero the value from a sensor). Find the tare value
before using this function.

Note: Make the value negative or positive as appropriate e.g. (2) - (2) =0,
(-2)-(-2)=0.

Asks for Value

(Snapshot Pre-log only)

This pre-log function will only be available in SnapShot mode. Each
time you click in the graph area to record a value, a dialogue box will
appear for you to type in a number from your keyboard.

Note: Enter a Name and Units as appropriate.

Manual Entry

Use this function to create a column full of zeros so that your own
data can be entered via the keyboard.

(To enter data, double click in a cell and type in your own data).

Add a constant

Use this function to add a number (constant) to each data point.

Subtract a constant

Use this function to subtract a number (constant) from each data
point.

Multiply by a constant

Use this function to multiply each data point by a number (constant).

Note: Alter the number of decimal places as appropriate.

Divide by a constant

Use this function to divide each data point by a number (constant).

Note: Alter the number of decimal places as appropriate.

Moving Average

This is a smoothing function. Each value is the mean of the previous

(simple) ‘a’ number of data points e.g. if a = 5, then the averages of data
points 1to 5, 2 to 6, 3 to 7 etc. will be taken.
Mean (x,a) The sum of all the values in a set of ‘a’ data points divided by ‘a’

e.g. ifa =15, an mean will be calculated for each set of 5 data points,
1to5,61to0 10, 11 to 15, etc.

Average of 2 Channels

Adds and divides the data from two Channels to show the average of
both channels.

Note: Alter the number of decimal places as appropriate.

Average of 3 Channels

Adds and divides the data from three Channels to show the average
of all three channels.

Note: Alter the number of decimal places as appropriate.
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Titration Asks for the Volume This pre-log function will only be available in SnapShot mode. Each
added time you click in the graph area to record a value from the pH
(Snapshot Pre-log only) Sensor, a dialogue box will appear for you to type in a number from
your keyboard. Enter the TOTAL volume added so far.
First derivative of pH Creates a sharp peak to identify the point of most rapid change in pH.
Convert Drops to Use this function to convert ‘number of drops’ to a volume
Volume measurement.
This function needs a value for the volume of one drop. Divide the
volume in cm® by the number of drops required to fill this volume e.g.
1cm®=27 drops, 1/27 = 0.037 cm® per drop.
Note: Alter the number of decimal places as appropriate.
Spirometer | Spirometer Air Flow to This function converts Air Flow data from the Spirometer to Volume.
Volume
Volume units = Litres (l)
Spirometer Volume drift | This function corrects Volume data (which has already been
correction calculated from the Air Flow data) for drift.
(Post-log only) Note: Volume data must be available to select. The multiplier and constant
values are pre-calculated.
Volume units = Litres (I)
Channel Multiply Channel by This function multiples the data of two Channels together
Channel
Divide Channel by This function divides the data from Channel one by Channel two.
Channel
Subtract Channel from This function subtracts the data of Channel two from Channel one
Channel (Channel one — Channel two).
Add two Channels This function adds the data from two Channels together
together
Oxygen % Saturation to mg/l This function converts Oxygen % saturation data to Oxygen in mg/l.
You will need to supply the Air Pressure (default 101.3 kPa) and the
Temperature ("C).
Conversion | Convert Degrees Converts Degrees to Radians.
(angles) to Radians
For Pendulum (+20°) adjust the minimum channel limits to -0.4 and
maximum channel limits to 0.4.
Radians to Degrees Converts Radians to Degrees
Celsius to Fahrenheit Converts Celsius to Fahrenheit
Fahrenheit to Celsius Converts Fahrenheit to Celsius
Celsius to Kelvin Converts Celsius to Kelvin
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Formula functions:
1. Click on the down arrow to view the formulae available and select from the list. The white panel at
the bottom of the window will give information about what the function will be calculating.

a Mean (x,a) a/(x"b) + ¢ a exp(bt) + ¢
ax + by ax’ atx+b a log10(bx) + ¢
ax - by alx’ +c at/x+b aloge(bx) + ¢

axy ax’+bx +c a sin(bx) + ¢ alog10(bt) + ¢
axly att +bt+c a cos(bx) + ¢ aloge(bt) +
alx+c a dy/dx a exp(bx) + ¢
(x-a)b a dx/dt asin(bt) + c
Movin_g average axl + ¢ a cos(bt) + ¢
(simple)
Click on Next.

2. Select the data channel(s) to be used as the source of x or y. Click on the arrow to reveal the
list of sensors connected (it's presented in the order of the connected sensor ports). With Post-
log functions the list will include any derived data channels.

Click on Next.

3. Edit the default name and units for the new set of data. Alter the number of decimal places to
be displayed if required.

Select whether the axis limits of this data should either expand to fit or use manual limits.

o0 Expand to fit - when the recording has finished, the axis will automatically redraw if data
has exceeded the limits taken from the original data.
0 Manual — use the limits of the axis as specified in the minimum and maximum boxes.

Note: The default value is based on the default limits of the first source channel used in the calculation. If
the maximum value calculated by the function is less than the source channel limits, apply Autoscale (see
page 33) to find the limits of the calculated data.

Enter any parameters required e.g. a and b are constants i.e. a number or scaler, c is an offset or
intercept number. Numbers can be negative or positive (make sure there isn’'t a space between the
+ or — sign and the number).

Click on Finish.

Notes:

= A negative number multiplied by a positive number creates a negative.

= A negative number multiplied by a negative number creates a positive.

= Any number multiplied by zero = 0.

= To remove part of a function set the constant’s (a or b) number to zero. E.g. To multiplying a data set by a
constant would require an ax function. The function ax + by can be altered to ax by setting b to 0 (0
multiplied by y = 0).

= A number multiplied by 1 gives the same number.

= To leave the value of a data set unchanged by a calculation then the value of a or b should be set as 1.
E.g. when adding two data sets there is no function x + y but there is ax + by. By setting both a and b to 1
makes the function ax +by = 1x +1ly = x +y.

If you are using a Pre-log Function, click on the Start/Stop icon. Data will be calculated and displayed
on the graph and table. Values will not be displayed in the data values boxes during logging.
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Best Fit = User Level 2 & 3

Select Best Fit from the Tools menu to calculate and produce a straight line which fits most closely
to the collected data. It can be applied to the whole set of data or to a selected part.

Note: If you want to apply an automatic line of best fit to only a part of the collected data, make your selection before
choosing Best Fit.

Add Line of Best Fit x

e Select the method of Best Fit

Automatic (computer calculated) - the line will be drawn automatically
across the entire range of the selected data.

Manual (drawn freehand) - lets you draw the line of best fit between
any two points

[T [ -
e Click on Next.
Add Line of Best Fit x
e Select the Axes for the line of Best Fit e —
Select Y-axis — select the data channel/sensor to which you want to e

fit to the line from the drop-down menu.

Select X-axis — the current X-axis will be selected by default. If the
X-axis is Channel, select the data channel to be used from the e () Ce=]

drop-down list.

o |If a part of the collected data was selected for an automatic line, choose whether you want to apply the
Best Fit line to the selected data only.

e Click on OK.
If Automatic was selected, the line will be drawn automatically.

If Manual was selected, click at the start point, move the mouse and a ‘rubber band’ line will follow,
click at the end point.

A manual best fit line can be adjusted. Click on the end point of the line, hold down and drag to its new
position.

To delete the best fit line, right click on the line and select Delete.
Information shown

Automatic: (y = bx + a), r* =
Manual: (y = bx + a)

e S
w=-72305 + 075 F=0570

y = the data channel selected T T
X = as selected (i.e. time, reading or a data channel) | |
b is the constant of the slope (gradient between two points)
a is the intercept

b = constant a = the intercept

ris a fraction between 0 and 1. A high r* tells you the line came very close to the points of data. When
=1, all points line up exactly on a straight line with no scatter (so knowing x would let you predict y
perfectly). An r? value of 0 means there is no linear relationship between x and y (so knowing x
doesn’t not help you predict y).

Note: The r? value is only available if an Automatic line is drawn.

Show Calculation Timing only

Use to show how a result has been calculated for a reading in Timing.

Select a reading from the table, and select Show Calculation from the Tools menu. The formula and
measurements used in the calculation will be shown.
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Click on Next to see the calculation for the next reading or Cancel to finish.
Note: A calculation will not be available for data collected using a Picket fence or Pulley.

Show Calculation EJ

Calculation for Acceleration at & with Double Intermupt Card

Accelerstion = Change in Velocity Accelerstion = 0.66556 m/s - 0 BO074 mds
Time Taken 012757 5

Accelerstion = 0.50804 m/s*

Individual graph choices

Some tool options i.e. Predict, Delete Predictions and Add Text are applied on an individual graph basis
rather than to all graphs displayed. These are available by a right click in the graph area of the individual
graph.

Predict

Used to anticipate the effect of a change to the measured parameter before data is recorded e.g. moving
a Temperature Sensor from hot to cold water. Predict lines can be drawn on a graph to predict where you
think the graph line will go.

To make a Prediction:
¢ Right click in the graph area and select Predict.

Show or Hide: Channels

Zoom In

¢ Click at the start point, move the mouse and a thick black line will Zoom off
appear. Use the line to draw a prediction on the graph. Click with the Auka scale graph Min Ma
mouse button at different points on the graph to fix the line in Auka scale graph 0 o Max
position. Right click to stop and deselect Predict. Fute scale channel M Max

Auko scale channel 0 to Max

e Record the data as normal to test the validity of your prediction. —

Add Text
Predict can be reselected to make up to twenty predictions on a time Tite
graph or up to ten for an XY graph.

To delete any unwanted prediction lines right click in the graph area and select Delete Prediction. Use
the forward and backward buttons to cycle through the prediction lines. As each line is selected it will turn
red on the graph. Click on the Delete button to erase the prediction.

Add Text

Used to annotate the graph with ‘text boxes’ that can be placed in
any position in the graph area. Each text box has a line which can be
made to ‘point’ to a part of the graph to which it refers.

[Placed in a beaker of ice |

¢ Right click in the graph area and select Add Text.

e A dialogue box will open. Type in the required text and OK.

Placed in a beaker of o]

Note: Select Enter on your keyboard to move to a new line.

¢ Move the cursor to the point on the line that you want the label
to refer to and click once.

o A ‘ghost’ rectangular box will appear, move it to the required position for the label. Click and the label
will appear.

© Data Harvest Group Ltd. 41



EASYSENSE software DO135 (6)

The label can be moved at any time - click on the label and drag using the mouse.

To edit or delete a label, right click on the appropriate label and select Edit or Delete.

Changing Settings

Changing a sensor’s range

Note: This option is specifically for use with Smart Q sensors and cannot be used with Sense & Control and
EASYSENSE Interfaces.

Some Smart Q sensors have multiple ranges e.g. a Light Level Sensor.The simplest way to change a
sensor’s range to one suitable for an experiment is:

0 e
¢ Select the New recording wizard icon . Reslilus Lotehe Nizad e

No Senme
No Senwe

Sound

e Click on the sensor’'s name (it will be listed
using its current range). ( ___4———— Click on Sensor’s name

¢ A set sensor range window will open; the - ' '
range currently selected will be highlighted. PR —

Note: If the sensor only has one range this (et ] E—
window won'’t open. Select Aange:

Ligh

o Select the required range, then OK. e _JJl_pu | cet

Indoor Tk b
In/Out 10k b

e Select Finish to exit the wizard. Didoen 00K I

e Select Sensor Config from the Settings menu.

o Select the sensor requiring configuration from the list. Click on the Change Range button.

Note: If no choice is available a message to say ‘This Sensor does not have multiple ranges’ will be displayed.

e Select the required range and click on OK.

Ik
o Close Sensor Config. Select the New recording wizard icon .and then Finish for the change in
range to be detected.

The sensor range setting will be retained until changed by the user.

Calibrate Sensor

Note: This option is specifically for use with Smart Q sensors and cannot be used with Sense & Control and
EASYSENSE Interfaces.

All Smart Q Sensors are supplied calibrated but certain Sensors allow the user to adjust the calibration
constants to the conditions of the experiment. This option allows the user to adjust the sensor reading at
either two or three points in its range. The adjustments made will affect the whole Sensor range,
between and beyond these points. The accuracy of the user calibration will depend upon the number of
calibration points used and their spacing.

For example:

The pH Sensor has a default calibration set for operation at a temperature of 25°C. If the samples being
measured are at a lower or higher temperature, then this default calibration may be improved by a ‘User
calibration’. Buffer solutions of a known pH are used to set the values for the calibration points. It is
essential that the buffer solutions used are at the same temperature as the samples in the experiment
and that the pH value entered is the value of the buffer at that temperature. For example, a buffer solution
with a pH of 7.01 at 25°C can change its value to 7.10 at 5°C, or 6.98 at 40°C.
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Select Sensor Config from the Settings menu.
Select the Sensor requiring configuration from the list.

Click on the Calibrate Sensor button

Note: If no choice is available a message to say ‘This sensor does not have User

Calibration’ will be displayed.

If you are using 3 test solutions to set the calibration points,
check the ‘Use Three point calibration’ box is ticked.

If only 2 test solutions are available, deselect the tick in the
‘Use Three point calibration’ box. Only the First and Last
calibration points will then be available.

Type in the test solution value of all the buffers that will be used
and click on Next.

Rinse the electrode thoroughly with distilled water.

Place the Sensor in the test solution with the lowest value e.g. pH
4 buffer. Agitate then leave for a minute until the reading shown in
the lower section of the Calibrate sensor window stabilizes, click
on the Next button — check the ADC value is entered alongside
the First Values box. Rinse the electrode thoroughly with distilled
water.

Place the Sensor in the test solution with the mid range value
e.g. pH 7 buffer. Agitate then leave for a minute until the
reading shown in the lower section of the Calibrate sensor
window stabilizes, click on the Next button — check the ADC
value is entered alongside the Second Values box. Rinse the
electrode thoroughly with distilled water.

DO135 (6)

Sensor Config @

Light (1]

Mo Sensar [%]
Mo Sensor [%]
Mo Sensar [%]
Mo Sensar (%]

Mo Sensor (%]

OO0OO0O0OCO®@

Mo Sensor [%]

Redetect

Change Flange

Calibrate Senzor

Logger Information

Close

Calibrate pH Sensor g

Calibration Points

Use three point calibration

First 0.00
Second 7.00
Last 14.00

Instructions

Enter the Test Solution values and click Nest

Current Reading Using

Default Calibration 0.00
Current User Calibration 0.00
Raw ADC 1}

Place the Sensor in the test solution with the highest value e.g. pH 10 buffer. Agitate then leave for a
minute until the reading shown in the lower section of the Calibrate sensor window stabilizes, click on
the Next button — check the ADC value is entered alongside the Last Values box.

A message to say ‘The User range has been programmed. Disconnect and reconnect the Sensor from
the EASYSENSE unit ‘will be displayed. Unplug the pH sensor from the EASYSENSE unit and then

plug back in. OK the message.

Click on Change Range button and select User Cal as the range and click on OK.

Close Sensor Config. Click on the New m icon then Finish for the change in range to be detected.

The User calibration values will be stored in the Smart Q Sensor and will be retained until recalibrated.

The lower section of the Calibrate sensor window displays the current reading from the selected sensor.
Default calibration — shows the current value recorded by the default calibration stored in the Sensor.
Current User calibration — shows the current value recorded by using the calibration points last

configured by the user.

Raw ADC — shows the value from the analogue digital converter in the EASYSENSE unit in a range
of 0 — 65535. This value is used by the software to calculate the calibration constants.

Logger Information
Click on the Logger information button to check the type and the firmware version number of the
EASYSENSE unit being used.
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Overla D. | Snapshot,
y . o3 ‘[W M Easylog

Select the Overlay icon from the toolbar or Overlay Mode and Graoh

from Settings, to add a new set of data to the graph without P

the previous set of data being erased - useful for repeating an

experiment to compare data.

Note: This option is not available in Scope or Timing.
Toolbar §|

Toolbar

These options let you choose whether to see small or large icons,
and whether the icons show text.

The options below define the way the toolbar is
displayed
[] Small Toolbar lcons

Smaller icons without text can be useful on low resolution displays, Displey Toclar Tert

as it gives more space to the main graph area. [

0K Cancel
)

Set Language
If a choice of language is available then Set Language will be listed in the Settings menu.

To choose a different language, select from the drop-down menu and OK. The program will close. Restart
to apply for your choice.

Show Columns Timing only
To show data used to calculate the final result

select Show Columns from the Settings menu in
T| m|ng . Select the columns to display
i . [] Time &2
T|Ck the bOX neXt tO any C0|UmnS yOU W0u|d ||ke [] Acceleration at & [] Time B1
displayed from the list. The columns available will EQLA:‘B g imif N
. . . EE ime to
vary depending on the Timing mode selected. 2 oo 0] T &1 to82
[] SpeedB1
[] SpeedB2
[] Time &1

Change Units Timing only

Select Change Units from the Settings menu to specify the units and number of
decimal places displayed (0 to 0.000000) in Timing. Each measurement has its own
drop-down menu.

Units
Time ms, s
Distance mm, cm, m
Speed/Velocity mm/s, cm/s, m/s, mph, km/h
Acceleration mm/s®, cm/s®, m/s®
Momentum g m/s, kg m/s
Kinetic Energy mJ, J

Show Data as Timing only

Data can be recalculated in another form without having to repeat an experiment using Show data as
from the Settings menu. The Timing Wizard will open, select how you want to show the current data and
enter any measurements required for the calculation. E.g. recalculate Distance data collected using a
picket fence to show Speed.
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Deleting data

Delete selected
Select the data that you want to delete — see page 26. Select Delete selected from the Edit menu and
confirm the deletion of the currently selected data.

If the data is recorded with a constant time interval between readings (Graph and EasyLog), the data will
be deleted but the time intervals will remain consistent. If readings are displayed as joined by a line, it will
redraw between the data points.

If data is recorded with an inconsistent time point (Snapshot), both the data and reading number will be
deleted and the graph will redraw.

Edit a value
Double click on the appropriate reading in the table, edit the value and select Enter on your keyboard.

Delete Data Sets
Use Delete Data Set from the Edit menu to erase an entire set of
data.

== (Jser Level 2 & 3

Erase Channel

Choose the channel of data to erase from the drop down menu.
Click on Erase and confirm the permanent deletion of the data
set from that channel.

Note: Once a data set has been deleted there is no recover option.

Merging data

[ 3
Merge with file & User Level 3
Select Merge with file from the File menu to merge the current data with a saved .SSL file. The data

must be recorded with a time base (not suitable for Snapshot data) and the intersample time of the data
must be the same for both.

Note: You may find it best to set up a recording using a method in which the intersample time for the recording is
specified e.g. Graph rather than using EasyLog if you intend to merge the resulting files
This option is not available at User Level 1 & 2.

Retrieve and Merge & User Level 3
Lets the current data merge with a data set retrieved from an EASYSENSE data logger. The

data must be recorded with a time base (not suitable for Snapshot data) and the intersample

time of the data must be the same for both.

Note: You may find it best to set up a recording with a specified intersample time e.g. using Setup Remote, to ensure
the interval between samples is the same (rather than EasyLog) if the intention is to merge the resulting data. This
option is not available at User Level 1 & 2.

Screen capture options
ltem Available in Description

Copy Table EasyLog, Snapshot, Used to copy the current Table onto the clipboard
Graph, Scope, Timer | from where it can be pasted into spreadsheet, word
processor or desktop publishing applications.

Copy Graph EasyLog, Snapshot, Used to copy the current Graph onto the clipboard
Graph, Scope, Timer | from where it can be pasted into word processor or
desktop publishing applications.
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Copy Window

Meters, EasyLog,
Snapshot, Graph,

Scope, Timer

Used to copy the current EASYSENSE window (as
displayed on the screen) onto clipboard where it can
be pasted into word processor or desktop publishing
applications.

Export Bitmap

Meters, EasylLog,
Snapshot, Graph,

Scope, Timer

Select Export Bitmap from the File menu to capture
and save whatever is shown in the graph and/or table

area as a bitmap image using a filename and
destination of your choice [default location is to the
currently logged on user’s My Documents
directory\EasySense Files\Data Files]. Saved as

.BMP type.
File menu option
Item Available in Description
Home Meters, Easylog, To return to the Home screen.
Snapshot, Graph,
‘ﬁﬁ Scope, Timer
New Easylog, Snapshot, | Use to set up a new recording e.g. opens Logging wizard.
m Graph, Scope, Timer
Open EasyLog, Snapshot, | Use to load previously saved data file. Locate the correct
Graph, Scope, Timer | E4sySense file (.SSL) or .SID file and click on Open.
[Default location is to the currently logged on user’'s My Documents
directory\EasySense Files\Data Files].
Save EasylLog, Snapshot, | Provided the file has been saved previously, the data will be
Graph, Scope, Timer | 5, tomatically saved, retaining the name given the first time it was
saved.
If you Save while only a selected part of the data is being used
then only the selected data will be saved.
Save As EasyLog, Snapshot, | A dialogue box will open to allow the captured data to be saved as
Graph, Scope, Timer | 5y EasySense file using a filename and destination of your choice.
Saved as .SSL type file.
[Default location is to the currently logged on user's My Documents
directory\EasySense Files\Data Files].
Note: The Save or Save As options are not available in Meters as the data
collected is live, but data recorded ‘behind the scenes’ can be transferred into the
Graph window and then saved.
Save Setup | Meters, Easylog, The settings for an experiment can be saved as a Setup file. This
Snapshot, Graph, allows the use of the same settings at a future date without going
Scope, Timer
through the set-up process.
e Set up the parameters for the experiment
e Select Save Setup from the File menu. Enter a name for the
experiment (which will be displayed in the Worksheet/Setup
window) and click on OK.
Enter a name for the experiment @
The temperature game
e Type in a file name for the EASYSENSE Setup file and Save to
the currently logged on user’'s My Documents
directory\EasySense Files\Setup Files as an .SSS type file.
See _page 49 for further information.
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Transfer to
Excel

(User Level 2

EasylLog, Snapshot,
Graph, Scope, Timer

Transfers the collected data into Microsoft Excel, if it is installed on
your computer. Excel will open a new worksheet with column
headings and data imported from EASYSENSE.

and 3 only)
Export as a | EasylLog, Snapshot, | Use to export (save) the collected data in a .SID or CSV file
SID/CSV file | ©Graph. Scope, Timer | format.
(Uze?: Le\I/eI 2 From the dialogue box select the Type as either SID or CSV and
and 3 only) enter a file name and destination of your choice.
Notes:
® Files saved in SID format contain information about units and measurements so
allow free exchange of data between a variety of data logging software systems
® Files saved in CSV format (comma-separated values) are a simple text format
suitable for database/spreadsheet systems e.g. Microsoft Excel.
Interface '\S/letefsﬁ EtaéyLO% Used to select the correct type of interface and the type of
. napshot, Graph, ;
selection Scope, Timer connection used.
Note: If the ‘Example Data’ option is selected you will not be able to collect data
from your interface or data logger. The example sensors will replicate data from
four sensors working at different values.
The program will save your selection so it will be automatically
configured when EASYSENSE is next used.
Printing
Page Set-up Meters, EasyLog, To set up the print output to suit your printer. Use to select
Snapshot, Graph, whether to print in landscape or portrait format.
Scope, Timer
Print Meters only To print out a copy of the current screen display
Print Graph EasylLog, Snapshot, | To print out a copy of the current graph
Graph, Scope, Timer
Print Table Easylog, Snapshot, | To print out a copy of the current table.

Graph, Scope, Timer

Note: A table can use multi-pages to print. Use Print Preview Table to establish
the number of pages before you decide whether to print.

Print Preview

Meters only

Use to view the printout before printing.

Print Preview
Graph

EasylLog, Snapshot,
Graph, Scope, Timer

Used to view the printout of a graph before printing.

Print Preview
Table

EasylLog, Snapshot,
Graph, Scope, Timer

Used to view the printout of a table before printing.

Other Home options
Optionz

Open File
Using then File from the Home screen menu is an alternative way to load
a previously saved data file. Locate the correct EasySense (.SSL) or .SID file and

click on Open.

Note: The default location is the currently logged on user's My Documents directory\EasySense Files\Data Files.
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Use then Worksheet from the Home screen menu to open an experimental worksheet together
with the software pre-configured for an investigation. Experimental worksheets can be written by the user,
or purchased as pre-prepared files. Some example pre-prepared files are included with this program.

A workroom file has both a
setup file and a directory
(with the same file name),
which contains an html file
named index.html.

Directory __".-J 01 Hows noisy, How quiet

Address ‘@ C\Program Files\DHG\EasySense Sefup FilesiWwarkroom files\Primary Easy Se

I/j 02 How bright, How dark
|
,’J 03 How warm, How cald

E 02 How bright, How dark 555
S55 File
1kB

E- 03 Howe wearm, How cold 555
S55 File
1KB

E 01 How noisy, How quiet. 555
555 File ]
LER

— Setup file

To open pre-prepared files:

e Open the Data Harvest Investigations
directory (1).

e Open the Workroom files directory (2).
Open the subject directory (3).
Locate the investigation and double
click on its setup file (5).

To open user saved files:

e Open the My Investigations directory (4).

e Locate the investigation and double
click on its setup file (5).

The worksheet for the investigation will open.

Set up the apparatus as required.

Click on the Launch icon to open the logging
option pre-set to record this investigation.

Note: The Cancel icon can be used to close the
worksheet and return to the directory window.

Use the To Experiment or To Worksheet
icons to swap between the worksheet and
the experiment window.

Note: The Forward and Back icons will remain inactive

until a hyperlink in the text is selected.
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To open a Setup

Use then Setup from the Home screen menu to open the software pre-configured for an
investigation. Some pre-prepared setup files are included with this program.

JM Data Harvest CosySense Software

= (1 Diata Harvest Investigaions (don 2| 1 01 P 1L 23 Sunkdorss
= Sehu L 01 Pubon - S
2 £ 02 At ginarics
L 03 Enced st
7 04 Pt 4 fusl

o O3 Photosyribassis and ight
e 10 Transpirstion burridity
e 11 Plant growth

s 12 Pegriation of body heat
! 12 Hak st

1 14 Swealing o eonl

Be
FU

e
¥
P
¥
¥
¥
:
L

oL 18 Dendorani:

1K Huxkelng

L7 Resction e push budlons
1 18 Hil the ks

B 19 Habitar

1 20 Pioteace and cavein

To open pre-prepared setup files:

¢ Open the Data Harvest Investigations directory.

e Open the Setup files directory.

e Open the subject directory.

e Locate the investigation and double click on its Setup file. One of the logging options e.g. Graph will
open pre-set to record this investigation.

To open user files: E
¢ Open the My Investigations directory or select the Open Setup icon.

e Locate the investigation and double click on its Setup file. One of the logging options e.g. Graph will
open pre-set to record this investigation.

Note: A Setup that has an associated worksheet can still be opened using Open Setup — the logging option will open
without opening the worksheet.

To Save your own Setup file

¢ Set up the parameters of an experiment using the appropriate logging option i.e. EasyLog, Meters,
Snapshot, Graph, Scope or Timing.

E.g. Select the Users level, recording times, interval between samples, any start conditions or pre-
triggers plus any options required for display i.e. show table, number of graphs, line thickness and
point style, grid on/off, X-axis, name, minimum and maximum limits, title, predictions, deselected
channels, pre-log functions, notes, overlay, etc.

e Select Save Setup from the File Menu.

¢ Type in a suitable name for the experiment - this Enter a name for the experiment X
is the name that will be displayed in the My Fed cabbage o a acid bass indicatol
Investigations list. Click on OK.

e The Save EASYSENSE Setup file dialogue box will open. Alter the file name if required and Save to
the currently logged on user’s My Documents directory\EasySense Files\Setup Files (.SSS type file).
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To associate a Worksheet to your Setup file

When you save the Setup file, make a note of the file

name used and the save location. ® Setup Files EIEIEI

Note: Default location is the currently logged on user's My File Edit View Faworte ~ &

Documents\EasySense Files\Setup Files directory. Q pack ~ () .? =

Create a new directory with exactly the same name as Address | c:ypocument v | G Go

the Setup file, in the same location. '-.g lREd cabbage.5S5 4— Saved Setup file
555 File

Load a word processor application capable of saving .

<+— New directory with

HTML format files e.g. Microsoft Office Word, Publisher //} —
the same name

or FrontPage. Create your worksheet document.

< o |
. . . age title: ed cabbage _an e Title. ..
Save the document as an index.html file into the :Ig B Rd . ‘g EET
. . lle name: index, html hd Save
directory that has the same name as the set up file. ozl [T RETWRT rmey— =

Note: Ensure that the file is saved as .html - some versions of Microsoft Word will save web pages as .htm
files, which will not be recognised by the setup. If so, type in the missing | (so .htm becomes .html).

Note: Applications used to create HTML files (such as MS Publisher) may want to create more than just the
index.html file e.g. pictures to go on the page that have been saved as GIF or JPG’s. If this is the case, ensure
that all of the files are saved in the same directory.

Select then Worksheet from the Home window in EASYSENSE. Select the appropriate
directory and then investigation from the list (using the name given for the investigation during the
saving process).

The HTML worksheet will open. Click on the Launch icon to open the logging option pre-set to
record the investigation.

Setup Remote

Select then Setup Remote to program a data logger to collect data independently from the
computer. The collected data is stored in the logger's memory to be retrieved by the computer at a later stage.

Note: The Set up Remote option is only available for data loggers that support remote data collection. If the
interface selected does not have this facility, the Remote option will either not appear or will be ‘greyed out'.

= User Level 1 has a simple two stage logging wizard to set up the available options before capturing data.

Stage 1: Sensor selection

Stage 2: Recording duration

Deselect the tick next to any sensors from which readings are not required.

To change a sensor’s range, click on the sensor’s name, when the set range window opens select the
required range, OK. If sensors have been altered after start up, click on the Redetect button to identify
the change of sensor.

Raal Tine Logging Wizard =
Click on Next. T

1 econd
2 seconds
£ s

Select the length of time that you want to record from the list.

The interval between each sample and the number of samples will
automatically alter when the time duration is selected. The range of
recording times available will vary according to which data logger is
used.

< Dok Friash | | Cancel

Click on Finish.

Click on the Start icon ﬂ to begin recording data.
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g8 User Level 2 and 3 has a three stage recording wizard.

Stage 1: Sensor selection

Deselect the tick next to any sensors from which readings are not required.If sensors have been
altered after start up, click on the Redetect button to identify the change of sensor.

DO135 (6)

To change a sensor’s range, click on the sensor’'s name, when the set range window opens select the

required range, OK.

Click on Next.

Stage 2: Recording duration

Select the total recording time from the list.
Select the interval between samples being taken.

The number of samples will automatically alter when the total

recording time and the interval between samples are selected.

The range of recording times will vary according to which data
logger is used.

Remote Setup Wizand E

Select the total recording time
2 seconds ~
5 secands
10 seconds
20 seconds
30 secand:

-

Select the interval between samples

Mumber of zamples: 600

<Back |

e Click on Next.

Stage 3:

e Select the Start condition as required.

This is used to set the condition required for the

recording to start. The choice of start conditions and

triggers available on this page will depend on both
the recording time selected and the data logger

used.

Mest> | [ Fish | [ Concel

Remote Setup Wizand EJ
Select Start Condition
O When Enter Pressed
) Trigger on Level
PreTri
Channel 3 5
(®) Ak Start
Above v [0 % O 5%
O Trigger on Digital Candition |2l
ok
O 100%
) Trigger on Time

<Back

Frish | [ Cancsl

When Enter Pressed - To begin recording as soon as you press Enter on the data logger.
When you click on Finish the settings will be downloaded and a message will appear on the
computer to inform that ‘The logger is now set up for remote logging’. Click on OK.

The data logger can be taken away from the computer and placed in the recording position. It will
not start logging until the Enter (or Go) button on the logger is pressed.

Trigger on Level - To begin recording when the selected sensor is ‘above’, ‘below’, ‘rises above’ or
‘falls below’ a set value e.g. when the value from a temperature sensor rises above 15°C.

A ’w
SET LEVEL SET LEVEK
Above Below
For example: - For example: -

To start recording
when the value from
the temperature
sensor is above
15°C.
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To start recording
when the value
from the
temperature sensor
is below 15°C.
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SET LEVE J SET LEVELl\
Rises above Falls below
For example: - For example: -

Logging will not start
until the temperature
value rises up above
the set level.

Logging will not start
until the temperature
value falls down to
below the set level.
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Trigger on Digital Condition - to begin recording when a digital sensor, connected to input A or B, is
On, Off, is rising to on or falling to off.

E.g. when used with Light Gates

!

/l If Falling to Off is selected, logging will start when
- the object has passed through the beam

”&&2&:« A
S /
4
/ If Rising to On is selected, logging will start when the
4 first part of the object breaks the beam
m“:’?’%

Trigger on Time - to begin recording at the time and date specified.
e Click on the Now button to set the current time and date using your computer’s clock.
e Alter Trigger on Time to a time and date in the future:
Click on the hour, minute, or second number and then use the up/down arrows to scroll the

number up or down.
Click on the date drop-down arrow and select a future date from the calendar.

Select any Pre Trigger requirements.

Note: This option will only become available a trigger on level or digital condition selected.

Pre-trigger will allow a percentage of samples to be stored before the trigger condition is met and
the remainder to be taken afterwards. For example, if 1,000 readings are to be taken and a 25%
pre-trigger is selected, 249 readings will be taken before the trigger condition is met and 750 on
and after the trigger.

Stage 4:

Click on Finish. Recording will start when the start condition you have selected is met. Recording
will stop when the selected time span has passed.

Retrieve Remote

Select then Retrieve Remote from the Home page to retrieve remotely captured data.
Retrieved data can be used in the same way as real-time data i.e. it can be analysed, saved and printed.

Note: This option will only be available for data loggers that support remote logging operations.

EASYSENSE VISION users:

Select Interface from VISION’s Home screen or its PC Connection menu. VISION’s screen will alter
to show its USB connected.

Select Remote » Retrieve Remote from the PC’s Home screen. A dialog box will open

showing a list of the sets of data presently stored in VISION.

Select the required set of data and click on the Retrieve button.

Note: If the ‘Erase the Data set from the Logger after Retrieve’ box is ticked, the data set selected will be
deleted after retrieval.

When you've finished using VISION as an interface, disconnect VISION from the USB port and
VISION will restart.
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EASYSENSE users: Collect Remote Data g]
Connect the data logger to the
computer. Select Remote » Lel i Tope Leseinio]
. 05 May 2006 15173 Analogue
Retrieve Remote from the Home 05 May 2006 15,17:02 Easylog
05 May 2008 15:16:54 Timi
screen. 05 hog 2006 151622 Logting

05 May 2008 15:14:53 Snapshot class 3
The Date and T|me Of recording iS 05 May 2008 151245 Easylog by the pond
set by the data logger. Type
indicates the method of recording
e.g. Analogue, EasylLog,

Snapshot, and Timing.

[] Erase the Data set fram the Logger after Retrieve

Select the required set of data and

click on the Retrieve button.

Choose Channels @
EASYSENSE Q 3 or 5 users: R ——
EasyLog or Remote data: Deselect the tick next to any sensors from
which readings are not required. o

Light
Timing Data: The Timing Wizard will open. Select how you want to s
retrieve the collected time data, the type of interrupter that was
used and any measurement required for the calculation of the data.

Sense & Control users:
e Connect Sense & Control to the computer. Ensure it is switched ON (Manual) and is not logging.
e Select Retrieve Remote from the Home screen.

Altering the default configuration for data, setup files and images

The default locations for the local data, setup file or pictogram image directory can be altered by changing
the AppConfig.txt file.

For 32-bit users this is located at C:\Program Files\DHG\EasySense\Objects. For 64-bit users it’s at
C:\Program Files (x86)\DHG\EasySense\Objects.

The default locations are:
DHGSetupDirectory=[ProgramFiles]\dhg\EasySense Setup Files
DHGSetupDirectoryV2=[ProgramFiles]\dhg\EasySense Setup Files V2
LocalSetupDirectory=[MyDocuments]\EasySense Files\Setup Files
LocalDataDirectory=[MyDocuments]\EasySense Files\Data Files
DHGPictogramDirectory=[ProgramFiles]\dhg\Pictogram Images
LocalPictogramDirectory=[MyDocuments]\EasySense Files\Pictogram Images

Open the AppConfig.txt file into Notepad. Locate and change to point to the directory you wish to set as
the new default. Once the AppConfig.txt file has been altered it should be saved.

If the setup files are to be stored onto a shared area on your network (rather than the local machine)
then the AppConfig.txt file must be altered on all computers running EASYSENSE.

Adding your own images

You can add pictogram images, saved in a *.jpg and *.png format to the selection available in either the
DHG pictogram directory [default location [ProgramFiles]\dhg\Pictogram Images] or locally
[MyDocuments]\EasySense Files\Pictogram Images].
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EASYSENSE Software Multi-user Site Licence

Definitions
The following expressions have the meanings given here:

e ‘DHG’ means Data Harvest Group Limited, being owner of all
intellectual property rights in the Software

e ‘Documentation’ means both printed and electronic user
documentation.

e ‘Software’ means the program supplied.

Licence

This software package may be freely used, copied, and
disseminated. This includes any associated documentation and
user guides.

The software may not be amended, changed or altered in anyway.

Limited Warranty and Disclaimer of Liability

The Software is supplied ‘as is’; DHG makes no warranty, whether
express or implied, as to the merchant ability of the Software or its
fitness for any particular purpose. In no circumstances will DHG be
liable for any damage, loss of profits, goodwill or for any indirect or
consequential loss arising out of your use of the Software, or
inability to use the Software, even if DHG has been advised of the
possibility of such loss.

General

These conditions supersede any prior agreement, oral or written,
between the licensee and DHG relating to the software.
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